
Design Guide: TIDA-010054
适用于 3 级电动汽车充电站的双向双有源电桥参考设计

说明

该参考设计概述了如何实现单相双有源电桥 (DAB) 直
流/直流转换器。DAB 拓扑具有软开关换向、器件数量

减少和效率高等优势。当功率密度、成本、重量、电隔
离、高电压转换比和可靠性是关键因数时，该设计大有

裨益，是电动汽车充电站和储能应用的理想之选。

DAB 中的模块化和对称结构支持堆叠转换器实现高功

率吞吐量和双向运行模式，从而支持电池充电和放电应

用。

资源

TIDA-010054 设计文件夹

UCC21710、UCC14141-Q1、AMC1311 产品文件夹

AMC1306M05、AMC1336、AMC1302 产品文件夹

TPS2640、TLVM13620、TMCS1133 产品文件夹

TPS7A20、TLV760 产品文件夹

TMS320F280039 产品文件夹

咨询我们的 TI E2E™ 支持专家

特性

• 具有单相移 (SPS) 和扩展相移 (EPS) 控制功能的双

向双有源电桥
• 为 SiC MOSFET 提供集成保护的智能栅极驱动器 

UCC21710
• 用于实现数字控制的 TMS320F280039 控制器

• 隔离式电压和电流检测
• 最大功率输出为 10kW
• 可实现 98.7% 的峰值效率和 98% 的满负载效率

• 初级电压为 700V 至 800V 直流，次级电压为 350V 
至 500V 直流 (SPS)
250V 至 500V (EPS)

• PWM 开关频率为 100kHz，并通过平面磁性元件减

小变压器尺寸
• 无需辅助组件即可实现软开关

应用

• 直流快速充电站
• 直流快速充电电源模块
• 电源转换系统 (PCS)
• 混合动力、电动和动力总成系统
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1 系统说明

由联合充电系统和 CHAdeMO® 管理的电动汽车充电标准不断变更，并推动实现更快的电池充电速率（通常要求

在充电站不到 30 分钟即为电动汽车充满电）。直流充电站通常属于 3 级充电器，可满足 120kW 至 240kW 之间

的极高功率等级要求。这些直流充电站都是独立的单元，包含交流/直流和直流/直流功率转换级。充电站内堆叠了

许多功率转换模块以提高功率等级，并实现快速充电。直流快速充电站不经过任何板载交流/直流转换器，为电动

汽车的电池提供高功率的直流电流，这意味着电流直接流到汽车电池。如今，路上行驶的大多数电动汽车只能处

理最高 50kW 的功率。而更新款的电动汽车能够以更高的功率充电。随着电动汽车的续航能力越来越强、电池越

来越大，人们开发的直流充电解决方案能通过高达 250kW 或以上的快速充电站为续航距离远的电动汽车电池充

电。

充电站中的直流/直流转换器必须能够在输入端接入三相 Vienna 整流器的整流总线电压（700V 至 800V），并在

输出端与电动汽车的电池连接，从而提供额定功率。直流/直流转换器在许多终端设备中都有重要应用，图 1-1 展
示了在充电站、太阳能光伏系统、储能系统和电动汽车牵引应用中的用例。
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图 1-1. 直流/直流转换器的作用

直流/直流转换器必须能够处理大功率等级。除此之外，转换器必须模块化，使单个功率级转换器单元并联，从而

将输出功率吞吐量按直流充电站标准的要求提高到更高水平。充电站的当前趋势正朝着能够处理双向功率流的转
换器发展。车辆到电网 (V2G) 等新措施涉及电动汽车的电池与交流电网之间的功率传输。双向直流/直流转换器能

够在正向工作模式下对电池进行充电，在反向工作模式下则可以将功率输送回电网，这可用于在峰值负载期间使

电网保持稳定。

功率密度和系统效率是直流充电站中转换器的两个重要要求。在高开关频率下工作可以减小磁性元件的尺寸。通
过改用更高的总线电压实现快速充电，可以在相同的电流水平下传输更多的功率。这有助于减小铜面积，从而提

高转换器的功率密度。转换器还必须是高效的，因为这样可以显著节省成本并减小散热解决方案尺寸。散热解决

方案尺寸减小，可直接使散热器小巧紧凑，而这反过来，又增加了转换器的功率密度。转换器还必须能够实现 

ZVS（零电压开关）和 ZCS（零电流开关）等固有软开关，而不必添加任何可能影响功率密度的大型无源器件。

直流/直流转换器必须能够与锂离子电池或铅酸电池无缝连接，这两种电池广泛应用于电动汽车充电站中。直流/直
流转换器还必须能够在高压侧与低压侧之间实现所需的电压转换，以及电隔离。

传统的开关器件在高电压开关速度方面存在限制，换言之，是器件的 dV/dt 能力有限。因为器件的开关切换时间

更长，这种缓慢的斜坡过程增加了开关损耗。开关时间增加，也会使控制系统中防止击穿和短路所需的死区时间
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增加。为此，使用了较新的开关半导体技术（例如具有高电子迁移率的 SiC 和 GaN 器件）开发解决方案。本参考

设计使用 SiC MOSFET 与 TI 的 SiC 栅极驱动器技术，展示其在效率和功率密度方面的潜在优势。

本文讨论分析了以下四种常见的拓扑：

• LLC 谐振转换器

• 相移全桥
• 单相双有源电桥
• CLLC 模式中的双有源电桥

根据该研究，本参考设计选择了双有源电桥，因为相对于其他同类拓扑，双有源电桥易于进行双向运行，并具有

模块化结构、有竞争力的效率以及出色的功率密度。本参考设计的重点是克服在为电动汽车充电站设计高功率、
双有源电桥直流/直流转换器时遇到的挑战。
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1.1 主要系统规格

表 1-1 列出了双有源电桥 (DAB) 直流/直流转换器的一些关键设计规格。该系统在输出功率为 10kW 时的满载效率

为 97.6%。

表 1-1. 主要系统规格

参数 规格 详细信息

输入电压范围 700V 至 800V DC 节 3.1

输出电压范围 250V 至 500V DC 节 3.1

输出功率额定值 10kW（最大值） 节 2.3.5

输出电流 26A（最大值） 节 2.3.5

效率 峰值效率 98.8%（4kW 时）满载效率 98.0%（10kW 时） 节 4.5

PWM 开关频率 100kHz 节 2.3.4.6

功率密度 > 2kW/L 节 4.5

电压纹波 < 5% 节 2.3.4.5

表 1-1 展示了输入电压范围为 700V 至 800V。之所以考虑此范围，是因为直流/直流转换器必须与前端 Vienna 整
流器和三相功率因数校正 (PFC) 电路连接，其输出便落入此范围内。此转换器还可以与输出在 400V 范围内的单

相 PFC 系统结合使用，而该单相 PFC 系统必须与 48V 和 72V 电池连接。

!
小心

请勿在无人照看的情况下使该设计通电。

警告

高电压！ 电路板中存在可接触到的高电压。可能发生电击。如电路板的电压和电流处理不当，则可能导致

电击、火灾或伤害事故。使用该设备时应特别小心，并采取相应的保护措施，以避免伤害自己或损坏财

产。为安全起见，强烈建议使用具有过压和过流保护功能的隔离式测试设备。

TI 认为在对电路板通电或进行仿真之前，用户有责任确认其已明确并理解电压和隔离要求。通电后，请勿

触摸该设计或与该设计相连的元件。

警告

表面高温！接触会导致烫伤。请勿触摸！

电路板上电后，某些元件可能会达到 > 55°C 的高温。在运行过程中或运行刚结束时，不得触摸电路板，因

为可能存在高温。

!

警告

TI 建议，该参考设计仅可在实验室环境中运行，不应视为成品 供一般消费者使用。该设计旨在环境室温下

运行，未在其他环境温度下进行运行测试。

TI 建议，该参考设计仅可由熟悉处理高压电子和机械部件、系统及子系统所存在相关风险的合格工程师和

技术人员 使用。

电路板中存在可接触到的高电压。如电路板的电压和电流处理不当或施加不正确，则可能导致电击、火灾

或伤害事故。使用该设备时应特别小心，并采取相应的保护措施，以避免伤害自己或损坏财产。
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2 系统概述

本节显示了双有源电桥 DC/DC 转换器的方框图。

2.1 方框图
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图 2-1. TIDA-010054 方框图

该参考设计由四个相互通信的主要部分组成：

• 电源板，包括功率级 SiC MOSFET、高频变压器、电流检测电子器件、栅极驱动器、电压和电流检测以及系统

电源树
• 支持数字控制的 TMDSCNCD280039C 控制卡
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2.2 重点产品

本节重点介绍了该设计中的关键元件，包括栅极驱动器、F280049 控制器、用于电流和电压检测以及生成电压基

准的隔离式放大器。

2.2.1 UCC21710

UCC21710 是一款电隔离单通道栅极驱动器，设计用于驱动高达 1700V 的 SiC MOSFET 和 IGBT。该器件具有

先进的集成保护特性、出色的动态性能和稳健性。UCC21710 具有高达 ±10A 的峰值拉电流和灌电流。输入侧通

过 SiO2 电容隔离技术与输出侧相隔离，支持高达 1.5kVRMS 的工作电压、超过 40 年的隔离栅寿命、12.8kVPK 的
浪涌抗扰度，并提供较低的器件间偏斜和 >150V/ns 的共模噪声抗扰度 (CMTI)。UCC21710 包括先进的保护特

性，如快速过流和短路检测、分流电流检测支持、故障报告、有源米勒钳位以及输入和输出侧电源 UVLO（用于

优化 SiC 和 IGBT 开关行为和稳健性）。可以利用隔离式模拟至 PWM 传感器更轻松地进行温度或电压感测，从

而进一步提高驱动器的多功能性并简化系统设计工作量、尺寸和成本。

2.2.2 UCC14141-Q1

UCC14141-Q1 是一款符合汽车标准的高隔离电压直流/直流电源模块，旨在为 IGBT 或 SiC 栅极驱动器供电。

UCC14141-Q1 集成了一个变压器和一个具有专有架构的直流/直流控制器，可实现高功率密度和非常低的发射。

高精度输出电压可提供更好的通道增强，从而实现更高的系统效率，不会对功率器件栅极造成过应力。

UCC14141-Q1 的输入电压支持电动汽车的磷酸铁锂电池宽电压范围 (8V-18V) 和 12V 稳压电源轨 

(10.8V-13.2V)，具有不同的输出功率。这款完全集成的模块具有片上器件保护功能，需要非常少的外部元件，可

提供额外的特性，例如输入欠压锁定、过压锁定、输出电压电源正常比较器、过热关断、软启动超时、可调隔离

式正负输出电压、使能引脚和开漏输出电源正常引脚。

2.2.3 AMC1311

AMC1311 用于输入和输出终端处的直流电压检测。该器件是一款隔离式精密放大器，其输出与输入电路由抗电磁

干扰性能极强的隔离栅隔开。根据 VDE V 0884-1 和 UL1577 标准，该隔离栅经认证可提供峰值高达 7kV 的增强

型电隔离。AMC1311 的高阻抗输入经过优化，可连接到高压电阻分压器或其他具有高输出电阻的电压信号源。器

件性能出色，支持在闭环系统中进行精确的低温漂电压或温度检测和控制。

有关该器件的更多详细信息，请参阅 AMC1311 产品页面。

2.2.4 AMC1302

AMC1302 是一款隔离式精密放大器，此放大器的输出与输入电路由抗电磁干扰性能极强的隔离层隔开。该隔离栅

经认证可提供高达 5kVRMS 的增强型电隔离，符合 VDE V 0884-11 和 UL1577 标准，并且可支持最高 1.5kVRMS 
的工作电压。该隔离栅可将系统中以不同共模电压电平运行的各器件隔开，并保护电压较低的器件免受高电压冲

击。AMC1302 的输入经优化，可直接连接低阻抗分流电阻器或其他具有低信号电平的低阻抗电压源。出色的直流

精度和低温漂支持在 –40°C 至 +125°C 的扩展工业级工作温度范围内，在 PFC 级、直流/直流转换器、交流电机

和伺服驱动器中进行精确的电流控制。集成的无分流器和无高侧电源检测功能可简化系统级设计和诊断。
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2.2.5 OPA320

OPA320（单通道）和 OPA2320（双通道）是新一代精密低压 CMOS 运算放大器，经过优化，噪声极低，带宽极

宽，同时可在低静态电流（仅为 1.45mA）下工作。OPA320 系列非常适合低功耗、单电源应用。低噪声 (7nV/√
Hz) 和高速运行使其同样非常适合驱动采样模数转换器 (ADC)。其它应用包含信号调节和传感器放大。OPA320 
具有零交叉失真的线性输入级，能够在整个输入范围内提供出色共模抑制比 (CMRR)，通常为 114dB。

有关该器件的更多详细信息，请参阅 OPA320 产品页面。

2.2.6 AMC1306M05

AMC1306 是一款精密 Δ-Σ 调制器，通过抗电磁干扰性能极强的电容式双隔离隔栅将输出与输入电路隔离开。该

隔离层经过认证，可以按照 DIN VDE V 0884-11 和 UL1577 标准提供高达 7000VPEAK 的增强型隔离。与隔离式

电源结合使用时，该隔离式调制器可将系统中以不同共模电压等级运行的各器件隔离，并防止电压较低的器件损

坏。AMC1306 输入针对直接连接分流电阻器或其他低电压电平信号源进行了优化。器件具有独特的 ±50mV 低输

入电压范围，可通过分流器显著降低功率耗散，同时具有出色的交流和直流性能。AMC1306 的输出位流采用曼彻

斯特编码 (AMC1306Ex) 或未编码 (AMC1306Mx)，具体情况因导数而异。通过使用集成式数字滤波器（如 

TMS320F2807x 或 TMS320F2837x 微控制器系列中的滤波器）来抽取位流，该器件可在 78kSPS 数据速率下实

现 85dB 动态范围和 16 位分辨率。曼彻斯特编码的 AMC1306Ex 版本的位流输出支持单线数据和时钟传输，无需

考虑接收器件的设置和保持时间要求。

2.2.7 AMC1336

AMC1336 是一款精密 Δ-Σ 调制器，通过抗电磁干扰性能极强的电容式双隔离隔栅将输出与输入电路隔离开。该

隔离层经过认证，可以按照 DIN VDE V 0884-11 和 UL1577 标准提供高达 8000VPEAK 的增强型隔离。与隔离式

电源结合使用时，该隔离式调制器可将系统中以不同共模电压等级运行的各器件隔离，并防止电压较低的器件损

坏。AMC1336 独特的双极±1V 宽输入电压范围和高输入电阻支持该器件直接连接高电压应用中的电阻分压器。当

与数字滤波器一起用来抽取输出位流时，该器件可在 82kSPS 数据速率下实现 87dB 动态范围和 16 位分辨率。在

高侧，AMC1336 由 3.3V 或 5V 电源供电。隔离式数字接口由 3.0V、3.3V 或 5V 电源供电。AMC1336 可在 –
40°C 至 +125°C 的更宽工业级温度范围内提供额定性能。

2.2.8 TMCS1133

TMCS1133 是一款电隔离霍尔效应电流传感器，具有业界出色的隔离功能和精度。该器件还提供与输入电流成正

比的输出电压，且在所有灵敏度选项下均具有出色的线性度和低漂移。具有内置漂移补偿功能的精密信号调节电

路能够在没有系统级校准的情况下，在温度和寿命范围内实现小于 2.5% 的最大总误差，或在一次性室温校准（同

时包括寿命和温漂）的情况下实现小于 1.5% 的最大总误差。交流或直流输入电流流经内部导体，所产生的磁场可

由集成式片上霍尔效应传感器进行测量。无磁芯结构消除了对磁集中器的需求。差分霍尔传感器可抑制外部杂散
磁场产生的干扰。低导体电阻将可测量电流范围提高至 ±96A，同时更大程度地降低功率损耗并降低散热要求。绝

缘能够承受 5000VRMS，加上最小 8.1mm 的爬电距离和间隙，可提供高达 1100VDC 的可靠寿命增强型工作电

压。集成式屏蔽可提供出色的共模抑制和瞬态抗扰度。固定的灵敏度使 TMCS1133 能够通过单个 3V 至 5.5V 电
源来运行，因此消除了辐射测量误差并提高了电源噪声抑制能力。
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2.2.9 TMS320F280039C

TMS320F28003x (F28003x) 是 C2000™ 实时微控制器系列中的一款器件，该可扩展、超低延迟器件系列旨在提

高电力电子设备的效率，包括但不限于：高功率密度、高开关频率，并支持使用 GaN 和 SiC 技术。

这些应用包括：

• 电机驱动器
• 电器
• 混合动力、电动和动力总成系统
• 太阳能和电动汽车充电
• 数字电源
• 车身电子装置和照明
• 测试和测量

实时控制子系统基于 TI 的 32 位 C28x DSP 内核，可针对从片上闪存或 SRAM 运行的浮点或定点代码提供 

120MHz 的信号处理性能。浮点单元 (FPU)、三角函数加速器 (TMU) 和 VCRC（循环冗余校验）扩展指令集进一

步增强了 C28x CPU 的性能，从而加快了实时控制系统关键常用算法的速度。

CLA 能够将大量的常见任务从主 C28x CPU 上卸载。CLA 是一款与 CPU 并行执行的独立 32 位浮点数学加速

器。此外，CLA 具有专用存储资源，可以直接访问典型控制系统中所需的关键外设。与硬件断点和硬件任务切换

等主要特性一样，ANSI C 子集支持是标准配置。

F28003x 支持高达 384KB (192KW) 的闪存，这些闪存分为三个 128KB (64KW) 存储体，支持并行编程和执行。

高达 69KB (34.5KW) 的片上 SRAM 也可用于补充闪存。

F28003x 上的实时固件更新硬件增强允许从旧固件到新固件的快速上下文切换，以尽可能减少更新器件固件时的

应用停机时间。

高性能模拟模块集成在 F28003x 实时微控制器 (MCU) 上，并与处理单元和 PWM 单元紧密耦合，以提供更好的

实时信号链性能。16 个 PWM 通道均支持与频率无关的分辨率模式，可控制从三相逆变器到功率因数校正和高级

多级电源拓扑的各种功率级。

通过加入可配置逻辑块 (CLB)，用户可以添加自定义逻辑，还可将类似 FPGA 的功能集成至 C2000 实时 MCU 
中。

各种业界通用通信端口（如 SPI、SCI、I2C、PMBus、LIN、CAN 和 CAN FD）不仅支持连接，还提供了多个引

脚复用选项，可实现出色的信号布局。快速串行接口 (FSI) 可跨隔离边界实现高达 200Mbps 的稳健通信。

C2000 平台新增了主机接口控制器 (HIC)，这是一种高吞吐量接口，允许外部主机直接访问 TMS320F28003x 的
资源。

是否想详细了解 C2000 实时 MCU 适用于实时控制系统的特性？查看使用 C2000™ 实时微控制器的基本开发指南 
应用手册，并访问 C2000™ 实时控制 MCU 页面。

C2000™ 实时控制微控制器 (MCU) 入门指南涵盖了 C2000 器件开发中从硬件到支持资源的所有方面。除了主要

的参考文档外，每个部分还提供了相关链接和资源，帮助用户进一步了解相关信息。

要开始使用，请参阅 TMDSCNCD280039C 评估板并下载 C2000Ware。
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2.2.10 TLVM13620

TLVM13620 同步降压电源模块是一款高度集成的 36V、2A 直流/直流设计，该设计组合了功率 MOSFET、屏蔽

电感器和无源器件，并采用增强型 HotRod™ QFN 封装。该模块的 VIN 和 VOUT 引脚位于封装的边角处，可优

化输入和输出电容器在布局中的放置。模块下方具有四个较大的散热焊盘，可在制造过程中实现简单布局和轻松

处理。TLVM13620 具有 1V 到 6V 的输出电压范围，旨在快速、轻松地实现小尺寸 PCB 的低 EMI 设计。总体设

计仅需四个外部元件，并省去了设计流程中的磁性和补偿器件选择过程。尽管针对空间受限型应用采用了简易的

小尺寸设计，但 TLVM13620 模块提供了许多特性，可实现稳健的性能：具有迟滞功能的精密使能端可实现输入

电压 UVLO 调节、集成式 VCC、自举和输入电容器可提高可靠性和密度、全负载电流范围内恒定开关频率以增强

负载瞬态性能、负输出电压能力以实现反向应用，以及 PGOOD 指示器可实现时序控制、故障保护和输出电压监

控。

2.2.11 ISOW1044

ISOW1044 器件是一款电隔离式控制器局域网 (CAN) 收发器，内置隔离式直流/直流转换器，无需在空间受限的隔

离式设计中使用单独的隔离式电源。低发射、隔离式直流/直流转换器符合 CISPR 32 辐射发射 B 类标准，在简单

的两层 PCB 上仅使用两个铁氧体磁珠。额外的 20mA 输出电流可用于为板上的其他电路供电。该器件具有一个集

成的 10Mbps GPIO 通道，有助于去除用于诊断、LED 指示或电源监控的额外数字隔离器或光耦合器。

2.2.12 TPS2640

TPS26400 器件是一款设计紧凑、功能丰富的高压电子保险丝，具有一整套保护功能。4.2V 至 42V 的宽电源输入

范围可实现对众多常用直流母线电压的控制。该器件可以承受并保护由高达 ±42V 的正负电源供电的负载。集成

的背对背 FET 提供反向电流阻断功能，因此该器件适用于在电源故障和欠压条件下要求保持输出电压的系统。负

载、电源和器件保护具有许多可调特性，包括过流、输出压摆率和过压、欠压阈值。TPS26400 内部可靠的保护

控制模块以及高额定电压有助于简化针对浪涌保护的系统设计。借助关断引脚，可以从外部控制内部 FET 的启用/
禁用，还可以将器件置于低电流关断模式。为实现系统状态监视和下游负载控制，器件提供故障和精密电流监视

输出。MODE 引脚有助于在三个限流故障响应（断路器模式、闭锁模式和自动重试模式）之间灵活地对器件进行

配置。
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2.3 系统设计原理

以下各节广泛概述了双有源电桥的工作原理。

2.3.1 双有源电桥与电源系统的类比

双有源电桥中两个电桥之间的功率传输类似于电源系统中两个电压总线之间的功率流。考虑两个电压源通过线路
电抗连接的情景，如图 1-1 所示。

j&L

V1 = VL00
V1 = VL-

Ø

Ø>0

Ø<0

图 2-2. 电压总线间的功率传输

图 1-1 显示了右侧的电压源相对于左侧的电压源而言是滞后的。因此，根据方程式 1，功率从左侧传输到右侧。

P = V1V2sin φωL (1)

同样，双有源电桥发生功率传输时，通过 MOSFET 的开关操作，变压器的初级侧和次级侧产生两个高频方波。这

两个高频方波彼此存在相移。功率从超前电桥传输到滞后电桥，通过反转两个电桥之间的相移，可以轻松地更改

此功率流方向。因此，可以在双有源电桥中轻松地获得双向功率传输，如图 1-1 所示。
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图 2-3. 双有源电桥
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2.3.2 双有源电桥 - 开关序列

在单相双有源电桥中，同时控制初级电桥和次级电桥。所有开关都采用 50% 占空比工作。对角开关会一起导通和

关断，因此每个电桥的输出都是方波。本节将详细阐述转换器的开关序列。为简单起见，假设变压器绕组比 n = 
1:1，可将其移除，以了解开关序列的说明。

根据电感器电流波形以及变压器初级侧电压与次级侧电压之间的相移，开关序列分为四个间隔。电压和电流波形

如图 1-1 所示。在间隔一期间，电感器电流波形既有正值也有负值，因此电流换向遵循图 1-1 和图 1-1 中所示的

方案。在此间隔期间，初级侧的开关 Q1 和 Q4 与次级侧的开关 Q6 和 Q7 传导电流。

Q3
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Q1

Q8

Q7

Cout
Cin Vp

+

± 

+

± 
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+ +

图 2-4. 间隔 1：负电感器电流
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图 2-5. 间隔 1：正电感器电流

在此间隔期间，初级侧上的电压 Vp 等于 V1，而次级侧上的电压 Vs 等于 V2。这两个电压之差会出现在漏电感器

上，并且此间隔期间的电流斜率可通过方程式 2 估算得出。

di V1 V2

dt L

�
 

(2)

在间隔二期间，电感器电流为正值。变压器初级侧上的电压为正值，等于 V1，且次级绕组上的电压为正值，等于 

V2。因此，这两个电压之差会出现在漏电感器上，并且此间隔期间上升电流的斜率可以通过方程式 3 计算得出。

di V1 V2

dt L

�
 

(3)
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在此期间，开关 Q1 和 Q4 保持导通，但由于次级侧上的电压现在为 V2 并且电感器电流为正值，因此开关 Q5 和 

Q8 会导通来传导电流。在 Q6 和 Q7 关断与 Q5 和 Q8 导通之间存在一个较小的死区时间时段。在此死区时间

内，会出现零电压开关 (ZVS) 现象，下一节中将对此进行详细说明。第二个间隔的换向序列如图 1-1 所示。

Q3

Q4 Q6

Q5

Q2

Q1

Q8

Q7

CoutCin Vp

+

± 

+

± 

V1 V2
Vs

+ +

图 2-6. 间隔 2

在间隔三期间，电感器电流开始从正峰值下降为负值，如图 1-1 所示。在此间隔期间，初级侧上的电压为 –V1，
而次级侧上的电压为 V2。这两个电压之差（即 (-V1-V2)）会出现在电感器上。因此，电流会以负斜率下降，如方

程式 4 所示。

di V1 V2

dt L

�
 �

(4)

在此间隔期间，开关 Q5 和 Q8 继续保持导通，但由于初级侧上的电压现在为 –V1，因此开关 Q2 和 Q3 会导通

来传导电流。图 1-1 和图 1-1 中分别显示了电感器电流 IL > 0 和 IL < 0 在两个方向上的导通情况。

Q3

Q4 Q6

Q5

Q2

Q1

Q8

Q7

Cout
Cin Vp

+

± 

+

± 

V1 V2
Vs

+ +

图 2-7. 间隔 3：正电感器电流
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Q3

Q4 Q6

Q5

Q2

Q1

Q8

Q7

Cout
Cin Vp

+

± 

+

± 

V1 V2
Vs

+ +

图 2-8. 间隔 3：负电感器电流

在间隔四期间，电感器电流继续为负值。在此间隔期间，初级侧上的电压为 –V1，而次级侧上的电压为 -V2。这

两个电压之差（即 (-V1+V2)）会出现在电感器上。因此，电流会以负斜率下降，如方程式 5 所示。

di V1 V2

dt L

�
 �

(5)

在此期间，开关 Q2 和 Q3 会继续保持导通，但由于次级侧上的电压现在为 –V2，因此开关 Q6 和 Q7 会导通来

传导电流，如图 1-1 所示。

Q3

Q4 Q6

Q5

Q2

Q1

Q8

Q7

Cout
Cin Vp

+

± 

+

± 

V1 V2
Vs

+ +

图 2-9. 间隔 4

图 1-1 展示了初级侧和次级侧上的开关的栅极脉冲。变量 Ø 表示初级侧 PWM 脉冲和次级侧 PWM 脉冲之间的相

移。Vp 和 Vs 表示变压器初级绕组和次级绕组上的电压。IL 表示变压器电流。
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Q1, Q4

Q2, Q3

Q5,Q8

Q6, Q7

Vp, Vs

IL

1 2 3 4 1 2 3 4

i1
i2

图 2-10. 栅极信号、变压器初级电压和次级电压以及电感器电流

2.3.3 双有源电桥 - 零电压开关 (ZVS)

在支路中的一个 MOSFET 关断与另一个 MOSFET 导通之间，存在死区时间。在此死区时间内，存储在电感器中

的能量会使 MOSFET 的输出电容放电，并在导通之前使其电压接近零。MOSFET 在导通时，其两端电压接近零

的这一现象称为零电压开关 (ZVS)。这是该拓扑的一项主要优势，由于其中一个电桥中存在自然的滞后电流，电

感存储的能量会导致滞后电桥的所有开关和超前电桥的部分开关出现零电压开关现象。这取决于存储的电感能量 
(EL = 0.5LI2)，用于对 MOSFET 的输出电容进行充电和放电 (EC = 0.5CV2)，这也取决于转换器的负载和输入输出

电压比。有关 ZVS 边界的更详细说明，请参阅节 2.3.4.2。这里用从间隔一到间隔二的转换来解释 ZVS 的原理。

可以对所有导通事件进行类似的分析。

从间隔一切换到间隔二时，初级侧开关 Q1 和 Q5 继续保持导通，而次级侧开关 Q6 和 Q7 关断，且开关 Q5 和 Q8 
导通。最初，当 Q6 和 Q7 导通时，其上的电压为零，而 Q5 和 Q8 阻止了整个次级电压。在死区时间期间，当次

级侧的所有开关都关断时，电感器存储的能量使电流循环，从而将 MOSFET Q5 和 Q8 上的电容器放电至零，并

将 MOSFET Q6 和 Q7 上的电容器充电至完整的次级电压。电流换向如图 1-1 所示。
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Q3

Q4 Q6

Q5

Q2

Q1

Q8

Q7

Cout
Cin Vp

+

± 

+

± 

V1 V2
Vs

+ +

C5:0 C7:92

C6:92 C8:0

图 2-11. 次级侧的 ZVS 切换 - 电容器

一旦电容器充电和放电，电流必须继续流动。电流将流过二极管 D5 和 D8，从而将 MOSFET Q5 和 Q8 上的电压

钳位至零，如图 1-1 所示。在下个间隔期间，MOSFET Q5 和 Q8 在零电压条件下导通，从而完全减少导通损耗。

靠近二极管的箭头表示二极管导通，而 MOSFET 关断。

Q3

Q4 Q6

Q5

Q2

Q1

Q8

Q7

Cout
Cin Vp

+

± 

+

± 

V1 V2
Vs

+ +

图 2-12. 次级侧的 ZVS 切换 - 二极管

同样，从间隔 2 切换到间隔 3 期间，初级侧的开关上会出现零电压开关现象，下一节中将对此进行说明。从间隔

二切换到间隔三时，次级侧开关 Q5 和 Q8 继续保持导通，而初级侧 Q1 和 Q4 关断，而 Q2 和 Q3 导通。最初，当 

Q1 和 Q4 导通时，其上的电压为零，而 Q2 和 Q3 阻止了整个次级电压。在死区时间期间，当初级侧的所有开关都

关断时，电感器存储的能量使电流循环，从而将 MOSFET Q2 和 Q3 上的电容器放电至零，并将 MOSFET Q1 和 

Q4 上的电容器充电至完整的初级电压。电流换向如图 1-1 所示。

Q3

Q4 Q6

Q5

Q2

Q1

Q8

Q7

Cout
Cin Vp

+

± 

+

± 

V1 V2
Vs

+ +

C1:91 C3:0

C2:0 C8:91

图 2-13. 初级侧的 ZVS 切换 - 电容器
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一旦电容器充电和放电，电流必须继续流动。电流将流过二极管 D2 和 D3，从而将 MOSFET Q2 和 Q3 上的电压

钳位至零，如图 1-1 所示。在下个间隔期间，MOSFET Q2 和 Q3 在零电压条件下导通，从而完全减少导通损耗。

靠近二极管的箭头表示二极管导通，而 MOSFET 关断。

Q3

Q4 Q6

Q5

Q2

Q1

Q8

Q7

Cout
Cin Vp

+

± 

+

± 

V1 V2
Vs

+ +

图 2-14. 初级侧的 ZVS 切换 - 二极管

2.3.4 双有源电桥 - 设计注意事项

在设计双有源电桥的功率级时，有许多因素至关重要。最重要的因素是漏电感的选择、所需的工作相移、输出电

容器的额定值、工作的开关频率、SiC MOSFET 的选择、变压器以及预期的 ZVS 工作范围。这些设计参数中有许

多是相互关联的，其中任何一个参数的选择都会直接影响其他参数。例如，漏电感的选择会直接影响传输的最大

功率，进而影响转换器在预期的功率电平下的工作相移。下述各节将详细讨论这些因素。

2.3.4.1 漏电感器

设计电源转换器系统的主要规格是输入电压 V1、输出电压 V2 和所需的最大功率传输。双有源电桥的功率传输关

系如方程式 6 所示。N 的理想值为 V1,nom/V2,nom，在此设计技术规格中该值为 1.6。

P = NV1V2φ π− |φ|2π2FsL (6)

其中

• V1 为初级侧电压

• V2 为次级侧电压

• N 是初级侧与次级侧的匝数比

• φ 是以弧度为单位的相移

• Fs 为开关频率

• L 是漏电感或耦合电感

方程式 6 展示了功率传输可以通过相移 φ 来控制，其中最大功率传输发生在 φ = π/2 时。

在 V1 和 V2 固定的情况下，根据所需的输出功率，还需要设计两个变量。这些是开关频率 Fs 和漏电感 L。当 FS 
设置为 100kHz 时，选择 35µH 的 L。这使得理论最大功率传输为 22.85kW。这在 10kW 目标功率之上留出一定

的余量，这是较低输出电压所需的。

电感器的选择定义了转换器开关节点中的最大电流应力。

图 1-1 展示了电感器电流波形。从此波形可以得出 i1 和 i2 点处的电流。i1 = 0.5 × 2 × φ− 1− d × π × Ibase (7)i2 = 0.5 × 2 × d  × φ + 1− d × π × Ibase (8)

其中
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• d 是方程式 9 中给出的转换器电压传输比

• Ibase 是转换器的标称基极电流，在方程式 10 中给出

d = N×V2V1 (9)

Ibase = V1ωL (10)

Vp, Vs

IL

1 2 3 4 1 2 3 4

i1
i2

图 2-15. 电感器电流波形

2.3.4.2 软开关范围

如节 2.3.2 中所述，零电压开关取决于电感电流 IL。为了在间隔一和间隔二之间启用 ZVS 转换，当 Q5 和 Q8 导通

时，IL 需要为正。此时的电流定义为 i1（参见方程式 9）。对于间隔二和间隔三之间的 ZVS 转换，IL 也需要为

正。这个电流点被定义为 I2（参见方程式 10）。对于间隔三和间隔四以及间隔四和间隔一之间的 ZVS 转换，IL 需
要为负。由于电流波形是对称的，因此这些点的电流等于 –i1 和 –i2。

在忽略 MOSFET 的输出电容的情况下，可以通过将公式方程式 9 和方程式 10 设为零并求解 φ 而得出 ZVS 范
围。这将根据输入和输出电压比 d 给出 ZVS 所需的最小相移。这将引出了方程式 11 和方程式 12。

φZVS, pri > 1− 1d × π2 (11)

φZVS, sec > 1− d × π2 (12)

由于相移与输出功率成正比，因此可以在输出功率与电压之比图上绘制 ZVS 范围，如图 1-1 所示。功率的正常值

为 Pbase。
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图 2-16. ZVS 范围和最大输出功率与电压之比

Pbase = V12ωL (13)

图 1-1 中的红线显示了特定电压比下可能的最大输出功率 Pout,max。对于轻负载（低于以黑色绘制的 ZVS 边界的

输出功率）和电压比 d < 1，次级侧会遇到硬开关；而对于 d > 1 和低负载，初级侧会遇到硬开关。对于电压比 

d，可以在非常低的负载下实现接近一个 ZVS。通过应用不同的控制机制，例如扩展相移、双相移或三相移控制，
可以增大 ZVS 范围。

扩展相移控制由软件实现并可用。相关详细信息，请参阅节 6。

2.3.4.3 电感对电流的影响

漏电感的选择还决定了转换器中的电流。方程式 14 和方程式 15 展示了经过变压器初级绕组和次级绕组的 RMS 
电流。计算额定工作点（其中 d = 1）的电流很重要，因为对于其他电压比，RMS 电流在传输相同功率时会增

加，如图 1-1 所示。RMS 电流将标准化为 Ibase（请参阅方程式 10）。

IP_RMS = 13× i12+ i22+ 1− 2φπ × i2 × i1 (14)IS_RMS = N × IP_RMS (15)
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图 2-17. 漏电感器中的 RMS 电流，可在不同的电压比下实现相等的输出功率

2.3.4.4 相移

转换器的相移取决于漏电感值。用于所需功率传输的相移可以由方程式 16 给出。

φ = π2 × 1− 1− 8 × Fs × L × PoutN × V1 × V2 (16)
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图 2-18. 相移变化与漏电感间的关系

图 1-1 展示了 V1 = 800V、V2 = 500V、N = 1.6、FS= 100kHz 且 Pout= 10kW 时所需的相对于漏电感的相移（以

度为单位）。图中显示了对于较小的电感值，能够以较小的相移获得最大的功率传输。为了对传输的功率进行精

细的控制，必须能够以精细的高分辨率步长来对相位进行调整。此外，较大的电感器能够在较大的相移值下获得

最大功率传输，从而实现更好的控制。对于所选的 L = 35µH，需要 23 度或 0.4 弧度的相移。
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2.3.4.5 电容器选型

双有源电桥中的输出电容器必须设计为能够处理纹波。图 1-1 说明电容电流是电流 IHB2 和输出电流 ILoad 之间的差

值，也称为 IOUT，如方程式 17 所示。图 1-1 中也展示了波形。IHB2 是整流和调节后的电感器电流。通过 Pout / V2 
可获得最佳输出电流 Iout。根据 Iout 和 IHB2 之间的差值，可以得到电荷 ΔQ（标记为蓝色）。然后，可以使用方程

式 18 来计算所需的电容，以获得允许的最大纹波电压。Icap = IHB2− Iout (17)

Cout = ΔQVripple (18)

由于电流波形取决于输入至输出电压比和相移，因此需要对所有临界情况进行此分析。

使用 MATLAB® 脚本可获取不同输入至输出电压比下的 ΔQ。该脚本首先对图 1-1 中所示的理想电容电流波形进

行插值，并减去 Iout。生成的波形为电容电流 IC,out。接下来，计算 IC,out 的积分。从 max(∫IC,out) 减去 min(∫
IC,out) 可得到 ΔQ。在 10kW 输出功率以及标称输入和输出电压下，得到的 ΔQ 为 12µC。在较低的输出电压

下，ΔQ 将增加至 50µC。使用方程式 18 和 5V 的电压纹波可产生所需的 10µF 输出电容。假设电容器中没有寄

生效应，这些是理想值。在当前设计中，使用了 ESR 相对较高的铝电解电容器。因此，需要 470µF 输出电容来

将纹波降低到 5%。在下一个设计版本中，将设计更改为具有更低 ESR 的薄膜电容器，从而能够显著降低输出电

容。
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图 2-19. 双有源电桥中的输出电流
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图 2-20. 输出电容器电流
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电容器还需要能够处理 RMS 电流，该电流通过方程式 19 计算得出。

IC, RMS = φ2 × π × 13 × iC22 + iC2 × iC3+ iC32 + 1− φ2 × π × 13 × iC12 + iC1 × iC2+ iC22 (19)

其中iC1 = i1 × N − Iout iC2 = i2 × N − IoutiC3 = − i1 × N − Iout
2.3.4.5.1 直流阻断电容器

功率级中引入了直流阻断电容器，以避免在电流不平衡的情况下变压器饱和。电流不匹配的 PWM 信号、栅极驱

动器中的传播延迟不匹配或系统中的其他不对称可能导致该饱和。尤其是在启动和负载瞬态期间，可能会产生不

平衡的电流。直流阻断电容器必须设计为能够处理变压器上的 RMS 电流，能够承受全电压并提供足够的电容，从

而不会显著影响开关节点电压波形。CDCBlock,min = 1004 × π2 × Fs2 × L = 7.2 μF (20)

2.3.4.6 开关频率

开关频率是影响电源转换器效率和功率密度的一个重要设计参数。输入和输出电压电平主要确定功率级中使用的
开关类型。在功率级中使用 SiC MOSFET 可实现高开关频率。在更高的开关频率下工作，可以减小磁体尺寸，有

助于改善散热条件，从而提高转换器的功率密度。因而，在选择开关频率时主要是针对给定效率目标在允许的散

热设计和变压器尺寸之间做出权衡。其次，如果 MOSFET 的输出电容 (Ecoss) 非常高，选择高开关频率会导致轻

载时的开关损耗更高，并影响效率。开关频率的选择还会影响到控制环路带宽的实现。结合考虑到所有这些参

数，本应用中采用了 100kHz 作为开关频率。

2.3.4.7 变压器选择

在电源设计中，变压器和电感器是影响设计尺寸的主要因素。提高工作频率可以缩小设计尺寸，增加开关频率超

过特定值便会影响功率模块的效率。这是趋肤效应在电流流经导体表面时的频率下会变得非常大。与趋肤效应类
似，还存在邻近效应，使电流仅在彼此最靠近的表面上流动。另外，从高频设计中的邻近角度来看，必须优化导

体尺寸和层数。借助平面变压器，可以实现更多的交错来减少邻近效应。可以对这种交错进行调整，以产生特定

的电流泄漏量，从而有助于功率传输并实现 ZVS。

与传统变压器相比，平面变压器可以提供以下优势，因此本参考设计中使用了平面变压器：

• 平面磁体具有非常高的功率密度。与具有相同功率额定值的传统变压器相比，它们更加紧凑小巧，占用空间更

少。
• 它们能够实现更多的交错来减少交流导体损耗。
• 各匝和各层之间的间距一致，因此寄生效应一致。漏电感和绕组内电容可以保持为易于预测且严格控制的值。

• 通过平面磁体可严格控制漏电感。
• 变压器尺寸紧凑，可以支持将变压器自身与额外的 场电感器集成，而无需在电路板上单独增加元件。

仅靠漏电感器无法确保直到轻载条件下一直保持软开关。如前所述，通过增加电感值来增加软开关范围时会增加 

RMS 电流。在实践中，选择漏电感以便只能在高达 ½ 或 ⅓ 额定负载条件下提供软开关。要增加软开关范围，可

以应用多相移控制。在某些应用中，由于硬开关导致的开关损耗增加对于低负载是可以接受的，因为导通损耗在

低负载下会降低。

2.3.4.8 SiC MOSFET 选型

如图 1-1 中所示，初级侧和次级侧的主功率级开关器件必须能够阻断全部的输入和输出直流电压。出于以下原

因，选择 SiC 开关：

• SiC MOSFET 的开关速度比传统 Si 器件更快，从而减少了开关损耗。

• 用于 DAB 应用的 SiC MOSFET 中的反向恢复电荷明显较小，因此减少了电压和电流过冲。
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• 导通状态电阻越低，将更显著地减少器件导通期间的导通损耗。

• 这些开关还能够阻止更大的电压，而不会出现击穿。

在本设计中，初级侧采用了导通电阻为 75mΩ 的 1200V Cree® 器件，而次级侧采用了导通电阻为 30mΩ 的 

900V、电压阻断 Cree 器件。这两个器件都是采用开尔文连接的四引脚器件，以获得更出色的开关性能。后续几

节中介绍了实际导通损耗和开关损耗的计算方式。

2.3.5 损耗分析

本节回顾了理论上可在双有源电桥中获得的效率数字。为了得出不同元件的损耗，计算了初级侧和次级侧的平均

电流和 RMS 电流。各个公式的实际推导详情不在本设计的讨论范围内。双有源电桥中的最大功率传输出现在相移

为 90° 时。然而，相移越高，则需要的漏电感越大，才能实现功率传输。使用较大的电感会导致初级侧和次级侧

的 RMS 电流增加，进而会影响转换器的效率。

图 1-1 展示了从 MATLAB 仿真中获得的相移与所需电感间的关系。表 2-1 中列出了系统规格。

表 2-1. 直流/直流转换器电气参数

参数 规格

相移 –0.44 < φ < 0.44 (rad)

总漏电感 35µH

匝数比 1：0.625

负载电阻 25Ω

输入电压 800V

输出电压 500V

输入电流 12.5A

输出电流 20A

输出功率 10kW

2.3.5.1 SiC MOSFET 和二极管损耗

由于功率级中使用 SiC，因此体二极管仅在死区时间导通，造成零电压开关 (ZVS)。在所有其他情形中，SiC 的通

道被打开以传导电流。初级侧的峰值电流通过方程式 7 和方程式 8 计算得出。对于标称运行条件：

• V1 = 800V
• V2 = 500V
• Fs= 100kHz
• Ts=10μs
• N = 1.6
• φ = 0.4rad
• P = 10kW
• L = 35μH

计算这些输入的 i1 和 i2 会得出 i1 = i2 = 14.3A。i1 = i2 仅适用于标称输出电压 V2 = V1 / N。

图 1-1 展示了初级侧上的开关的电流波形。RMS 值可以通过公式方程式 21 计算。插入上述值会使初级侧开关的 

RMS 电流为 9.67A。

Iswitch, prim, rms = 16 × i12+ i22+ 1− 2φπ × i2 × i1 = 9.67 A (21)

二极管在开关周期内只导通一小段时间，如导致 ZVS 的死区时间。此应用选择的死区时间为 200ns。

Idiode, prim = i2 × tdeadTs   = 0.286 A (22)

与施加的栅极电压波形对应的漏源电阻值可从 SiC MOSFET 数据表中获取。该值为 75mΩ。体二极管上的正向压

降为 5.5V。四个初级侧 FET 上的导通损耗可通过方程式 23 计算得出：
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Pcond, prim = 4 × Iswitch, prim, rms2 × Rds, on+ Idiode, prim × Vfd, prim = 34.34 W (23)

同样地，通过使用方程式 24 和方程式 25 对初级侧 RMS 电流与变压器匝数比来计算次级侧 FET 上的导通损耗。

次级侧 MOSFET 的导通电阻为 30mΩ。体二极管上的正向压降为 5.5VIswitch, sec, rms = N  × Iswitch, prim, rms = 15.47 A (24)Idiode, sec = N  × Idiode, prim = 0.458 A (25)

Pcond, sec = 4 × Iswitch, sec, rms2 × Rds, on+ Idiode,sec × Vfd, sec = 37 . 88 W (26)

Q1, Q4

Q2, Q3

Q5,Q8

Inductor current 

waveform

1 2 3 4

i1
i2

Dead time between Q1/Q4 

and Q2/Q3

Phase shift

Q1, Q4 switch waveform

图 2-21. 用于计算电流 RMS 值的开关电流波形
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制造商提供的开关损耗曲线用于计算开关损耗。

由于 FET 在零电压下导通，因此仅使用关断损耗系数来计算开关损耗。使用 C3M0030090K 数据表信息，估计在

此运行条件下的关断能量为 60μJ。可以使用方程式 27 中的信息获取每个器件的开关损耗值。这会导致次级侧的

开关损耗为 24W。Psw, tunroff, sec = Fs×Eoff = 6 W (27)

对于初级侧开关 C3M0075120K，关断能量估计为 75μJ。这可得出初级侧的开关损耗为 30W。Psw, tunroff, prim = Fs×Eoff = 7.5 W (28)

所有八个开关上的初级侧和次级侧的总关断开关损耗为 54W。

这些计算是在标称工作条件下完成的。对于不同的工作点，需要调整这些计算。对于非标称输出电压，可能会丢

失零电压开关，并且必须考虑导通损耗。

2.3.5.2 变压器损耗

对于本参考设计，选择了平面变压器，并按照表 2-2 中所示的规格进行设计。正常运行条件下的估计功率损耗为 

50W。

表 2-2. 变压器技术规格

功能规格 等级

总输出功率 10kW (500V/20A Adc)

运行频率 100kHz 至 200kHz

变压器输入电压 800V (VOUT = 500V)，双极方波

伏秒乘积 8000Vμs – 对于 VOUT = 500V，100kHz

初级/次级匝数比 24:15

初级电流最大值 13.5Arms（20A 峰值）– 对于 VOUT = 500V

次级电流最大值 20Arms（30A 峰值）– 对于 VOUT = 500V

估算功率损耗 50W – 对于 VOUT = 500V，100kHz；

初级绕组直流电阻 43mΩ

次级绕组直流电阻 16mΩ

漏电感 34µH

磁化电感 720µH

Payton 提供了关于该变压器的更多详细信息。

2.3.5.3 电感器损耗

此设计使用的电感器是一个定制电感器，该电感器集成在 Payton 平面变压器中。总漏电感为 34µH，制造商提供

的总估算功率损耗为 15W（对于 VOUT = 500V，Fs=100kHz）。
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2.3.5.4 栅极驱动器损耗

栅极驱动器电路中的功率损耗包括 UCC21530 中的损耗和栅极电阻器等外围电路中的损耗。功率损耗由静态功率

损耗组成，其中包含驱动器在一定开关频率下工作时的静态功率损耗以及驱动器的自身功耗。输入 Vcc 引脚 

(IVCCQ) 和 VDD 引脚 (IVDDQ) 的静态电流均能从数据表中获得。PQ = VCC × IVCCQ + VDD × IVDDQ = 3 . 3 V × 3 mA + 15 V × 4 mA = 70 mW (29)

通过将数据表中的值代入方程式 29，可以得到栅极驱动器的静态功率损耗 PQ 约为 70mW。栅极驱动器损耗的另

一分量是开关操作损耗。从而使八个栅极驱动器产生 560mW 的总功率。Psw = 2 × VDD− VEE × QG × Fs = 0 . 2 W (30)

通过在方程式 30 中代入值 VDD = 15V、VEE = –4V、FSW = 100kHz、QG = 53nC，初级侧上的每个 FET 的开关

损耗为 0.2W。C3M0075120K（初级侧 MOSFET）的栅极电荷从数据表中提取。同样，对于次级侧，计算出的开

关损耗约为 0.33W。C3M0030090K MOSFET 的栅极电荷 QG 为 87nC，并从数据表中获得。另外，在 MOSFET 
的导通和关断期间，栅极电阻器上会产生损耗。导通和关断栅极电阻为 2Ω。选择这些电阻器是为了抑制栅极上的

振荡。在开关过程，栅极驱动器 IC 能够提供 10A 峰值拉电流和 10A 峰值灌电流。利用此电流脉冲在一个开关周

期内的平均值，可以通过方程式 31 得出栅极电阻器上产生的导通损耗和关断损耗。

Pcond = QG × VDD− VEE × Fs2 × RonRGin + RoffRGin = 18 mW (31)

初级侧每个开关的该值为 18mW，次级侧每个开关的该值为 30mW，总计 192mW。因此，所有栅极驱动器上产

生的总损耗约为 3W。

2.3.5.5 效率

表 2-3 总结了前面几节中的损耗数据并计算出了

10kW 时的理论效率。

表 2-3. 损耗分析

损耗类型 损耗（瓦特）

初级侧和次级侧中的 SiC 导通损耗 72

SiC 关断开关损耗 54

变压器损耗 50

栅极驱动器损耗 + 分流电阻器损耗 3

电感器损耗 15

效率 98%

2.3.5.6 散热注意事项

散热器用于冷却 CR201-50VE。每个散热器安装两个 FET，因此，必须在 FET 的外露漏极和散热器之间使用绝

缘。使用 CD-02-05-247 绝缘板。此外，还安装了两个 12V (CFM-6015V-154-362) 风扇，以提供足够的气流。散

热器数据表提供了 0.5C/W 的热阻 (Rth,HS)。绝缘板增加了另一个 0.1C/W (Rth,iso) 的热阻。初级侧 FET 
C3M0075120K 的热阻 Rth,JC 为 1.1C/W，最高工作温度为 150°C，而次级侧 FET (C3M0030090K) 的热阻 Rth,JC 
为 0.48C/W，最高结温为 150°C。根据此信息，每个 FET 的最大允许功率耗散可通过方程式 32 来计算。这假设

像在参考设计中一样，2 个 FET 连接到一个散热器。

Pmax = TJ,max− TA2 × Rth, HS + Rth, iso + Rth, JC (32)

这会导致在假定环境温度 TA 为 40°C 的情况下，初级侧每个 FET 的最大损耗为 50W，次级侧每个 FET 的最大损

耗为 69W。
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3 电路说明

3.1 功率级

图 1-1 展示了单相双有源电桥的功率级。初级侧由 1200V、75mΩ 碳化硅 FET C3M0075120K 组成，以阻止 

800V 的直流电压，而次级侧由 900V、30mΩ 碳化硅 FET C3M0030090K 组成，以阻止 500V 的直流电压。全桥

与高频开关变压器 (T1) 连接。四个 CR201-50VE 散热器与两个风扇相结合，用于冷却 FET。在 FET 和散热器之

间使用 CD-02-05-247 绝缘板，以提供必要的绝缘和良好的散热界面。
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图 3-1. 功率级
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3.2 直流电压检测

3.2.1 初级侧直流电压检测

图 1-1 展示了初级电压检测电路。待检测的最大初级输入电压为 800V，并通过电阻分压器网络缩小至 1.57V，与 

AMC1311 的 2V 输入兼容。图 1-1 展示了用于降低初级电压信号的八个 634kΩ 电阻和一个 10kΩ 电阻。然后，
该信号由 OPA2320 的一个通道处理，从而根据 ADC 的要求在 0V 至 3.3V 范围内转换该信号。
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0
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图 3-2. 初级侧直流电压检测

图 1-1 展示了为 AMC1311 供电的隔离式电源电路。需要 3.3V 的隔离式电源为 AMC1311 的初级侧供电。隔离式

电源与由 UCC1414-Q1 生成的低侧栅极驱动器辅助电源共享。使用 UCC14141-Q1 的 15V 输出电压，但需要使

用 TLV760 为 AMC1311 生成 5V 电压。这种隔离式电源还用于初级侧的隔离式电流检测。

3.2.2 次级侧直流电压检测

在次级侧，使用隔离式调制器进行电压检测。次级侧感应距离控制器远，因此此处首选数字接口。数字接口不会

受噪声的影响，因此更适合在电源转换系统内放置长布线。所需的时钟由微控制器的备用 PWM 模块生成。输出

比特流被馈送到 C2000 的 SDFM 模块。在 SDFM 模块中使用可配置抽取滤波器可以实现精确测量和快速保护。

500V 电压按比例缩小至 0.76V，适合 AMC1336 的 ±1V 输入。
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图 3-3. 次级侧输出电压检测
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3.2.2.1 次级侧电池电压检测

除了直流电压检测之外，继电器内部还会实施电池电压检测，允许从初级侧进行有源预充电。该调制器使用与继

电器内部的直流电压检测相同的时钟。输出连接到另一个 SDFM 通道。对于电阻分压器，有两种情况。如果继电

器开路，GND_SEN_SEC 相对于 VBATT_N 悬空。在完整的电阻分压器处于活动状态的情况下，将 500V 向下调

节至 0.33V。在继电器处于闭合状态的情况下，VBATT_N 与 GND_SEN_SEC 短接；因此，只有电阻分压器的上

部处于活动状态。在此配置中，500V 被缩小至 0.65V。

VBATT_P

GND
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40.2
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CLK_MOD
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3

AGND
4

CLKIN
7

DGND
5

DOUT
6
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1
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0.1uF
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GND
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16V
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2.2µF
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634k
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634k
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3.32k
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图 3-4. 次级侧电池电压检测
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3.3 电流检测

电流检测对于过流检测并使闭环系统准确地工作非常重要。在此设计中，电流检测是在多个位置使用不同的检测

方法完成的。第一种是在输入和输出侧直流终端上使用电流检测电阻器。初级侧采用隔离放大器 AMC1302，其输

入电压为 50mV。因此，使用 3mΩ 分流电阻器将 12.5A 的最大输入电流转换为 37.5mV。
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C133

C134

GNDGND
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0.1uF
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330pF
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0R137

0R141
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图 3-5. 初级侧输入电流检测

隔离式调制器 AMC1306M05 用于次级侧。此处，1.5mΩ 分流器将 20A 的最大输出电流转换为 30mV，适合 

AMC1306M05 的 50mV 输入。现在，对于较低的输出电压，可实现更高的输出电流，这可能需要更小的分流器来

测量整个电流范围。

10.0

R89

10.0

R91 82nF

C89

GND

L8

40.2

R92

CLK_MOD
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3

AGND
4

CLKIN
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1
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TP13

5015

I_OUT_P

I_OUT_N

C83
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图 3-6. 次级侧输出电流检测

霍尔传感器 TMCS1133 用于测量初级侧和次级侧的变压器电流。此处首选霍尔传感器，因为在开关节点实现过流

保护时需要较低的传播延迟。TMCS1133 具有 1MHz 带宽，这是在 100kHz 开关频率下测量准确电流波形所必需

的。TMCS1133 还提供内置过流保护，该保护在初级侧设置为 45A，在次级侧设置为 70A，由 VOC 引脚上的电

阻分压器实现。故障输出可指示这种过流情况。此引脚连接到 C2000 MCU 的 GPIO，该 GPIO 配置为在发生过

流时触发 PWM 信号。
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100nF

C147

GND

GND

GND

GND

I_TANK_PRI

FLT_PRI

3.9nF

C153

10.0k

R164

68.1

R168
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i
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图 3-7. 变压器电流检测

3.4 电源架构

此参考设计的电源树由多个提供必要系统电压的 IC 组成：

• 运行电路板需要一个外部 12V 电源。此 12V 电压轨直接为风扇、继电器和 UCC14141 隔离式辅助电源供电

• 5V 连接到控制卡和 3.3V LDO
• 两个 LDO 用于为 C 生成 3.3V 数字电源和 3.3V 模拟电源

• 隔离式辅助电源为栅极驱动器提供 +15V 和 4V 电压

• 高侧使用 LDO 生成隔离式 5V 电源，为隔离式感应电路的高侧供电

3.4.1 辅助电源

外部电源直接用于为风扇、继电器和隔离式辅助电源供电。因此，电子保险丝 TPS2640 用于保护系统。过压保护

设置为 15V，欠压锁定设置为 9V，电流限制设置为 2.2A。有关详细的设计过程，请参阅器件数据表。两个 LED 
用于指示状态。绿色 LED D8 表示正常状态，而红色 LED D6 表示故障状态。使用 S1 按钮复位器件。
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图 3-8. 电子保险丝电路
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电源模块 TLVM13620 用于从输入生成 5V 电源轨。LED D10 指示 5V 输出。采用具有集成电感器的模块可实现设

计简易性和小外形尺寸。
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5V 40.0k
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50V
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R84

图 3-9. 5V 电源模块

两个 LDO 用于生成 3.3V 模拟电压轨和 3.3V 数字电压轨。
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NC
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OUT
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GND
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2
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图 3-10. 用于模拟和数字 3.3V 电压轨的 LDO
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3.4.2 栅极驱动器辅助电源

选用 UCC14141 器件作为隔离式辅助电源。这是一种具有集成变压器的隔离式辅助电源模块，可提供超小的尺寸

和高度。在双电源轨配置中，输出被配置为 +15V 和 –4V。每个器件的最大功耗可使用产品文件夹中提供的 

UCC14141-Q1 计算器工具进行计算。借助此工具，可计算限流电阻器 (RLim)（图 1-1 中的 RLIM）的值。此处为

仅提供一个栅极驱动器的器件选择 1kΩ，为提供一个栅极驱动器和隔离式感应高侧的器件选择 600Ω。每个输出

都连接到一个 LED，从而指示存在隔离式电源。电路板上有一些预防措施可在每侧的两个低侧 FET 之间共享隔离

式辅助电源。对于该跳线，需要放置电阻器，并需要调整 RLim。这还未经过测试。此外，还可以为高侧 FETS 安
装自举电源，但这尚未经过测试。
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图 3-11. 栅极驱动器辅助电源电路

3.4.3 检测电路的隔离式电源

若要为隔离式放大器和调制器生成隔离式电源，可重复使用低侧栅极驱动器辅助电源。使用具有固定 5V 输出的 

TLV760 将 15V 隔离轨向下转换为 5V 轨。输入端使用串联电阻来降低 LDO 中耗散的功率。

50V

0.1uF
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GND
3
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U16

160
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50V
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GND_BOT1
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D12

-4V_BOT1100k

R131

220

R14

图 3-12. 源自栅极驱动器辅助电源的电压和电流检测电源
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3.5 栅极驱动器电路

UCC21710 用作栅极驱动器。选择该器件是为了实现 SiC 的集成功能，例如 DESAT 保护、内部有源米勒钳位和

软关断。PWM 互锁可确保 H 桥上的两个互补 PWM 始终处于打开状态。模拟至 PWM 通道可用于高侧隔离式温

度检测。使用器件产品文件夹中的 UCC217xx XL 计算器工具将 DESAT 电压配置为 6.4V，消隐时间为 1μs。
UCC21710 的欠压锁定功能用于检查隔离式电源 (VCC) 和非隔离式电源 (VCC) 是否均在 RDY 引脚上指示的有效

范围内。

COM
3

OUTH
4

VDD
5

IN-
11

RST/EN
14

FLT
13

RDY
12

OUTL
6

CLMPI
7

IN+
10

AIN
1

APWM
16

OC
2

GND
9

VEE
8

VCC
15

UCC21710QDWQ1

U29

+15V_TOP1

-4V_TOP1

GND

GND

100nF

C187

GND

GND

2.0

R216

2.0

R209

2 1

D14

US1Q-TP

PWM1A_1

PWM1B_1

RDY

RST

DESAT_PRI

G1H_P

D1H_P

S1H_P

GND_TOP1

GND_TOP1

GND_TOP1

330pF

C188

15.0k

R208

18.0k

R217

2.00k

R223

100

R200

100

R202

100

R220

100pF

C185

100pF

C183

100pF

C175

1µF

C186

0.1uF

C173

1uF

C174

0.1uF
C169

0.1uF

C178

3.3uF

C170

0.47uF

C179

3V3_D

GND_TOP1

t°

TMP6131DECR

RT1
R16

GND_TOP1

0.1uF

25V

C78

TMP_HB1_P

0R85

0R147

图 3-13. UCC21710 栅极驱动电路

3.6 附加电路

隔离式 CAN 收发器 ISOW1044 用于启用 CAN 通信。该器件通过 D-Sub 9 引脚连接器连接到 MCU。在该设计的

当前状态下未实现 CAN 通信。

TMUX1204 用于将 UCC21710 APWM 通道的输出连接到控制卡连接器。SN74LVC126A 缓冲器用于转接驱动 

PWM 信号。

3.7 仿真

为了支持对本参考设计进行评估，产品文件夹中提供了 PLECS 仿真平台。该仿真可用于在效率和热行为方面评估

单相移调制和扩展相移调制。此仿真可与 MATLAB 和 Simulink 结合用于 PLECS 单机和 PLECS 块集。

备注
PLECS 是第三方工具。此工具可作为 PLECS Blockset（MATLAB Simulink 扩展）或独立提供。如需

更多信息，请参阅 plexim.com。
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3.7.1 设置

图 1-1 展示了可下载文件的文件夹结构。

图 3-14. PLECS 仿真 - 文件夹概述

图 1-1 展示了 PLECS 仿真平台。

图 3-15. PLECS 仿真平台

PLECS 仿真平台由三个主要部分组成：

1. 电源转换器：
a. 包含功率转换器，具有制造商碳化硅场效应晶体管 (SiC-FET) 模型

b. 散热器，设置与 TIDA-010054 类似，用于热分析

c. 用于分析开关节点波形的主要作用域

d. 次级示波器，用于分析输出电压、电流和功率

e. 用于分析变压器磁行为的 BH 曲线

2. 相移控制：
a. 包含电压和电流环路控制器。允许通过打开相移控制块并更改控制器的配置在电压和电流环路之间切换。

b. 可以通过在初始化脚本中设置 EPS_EN = 1 来启用扩展相移调制。

3. 测量子系统：
a. 测量并累加系统中的损耗，以计算效率

b. 用以查看输入电源的显示屏。仿真运行时的输出功率效率和损耗

c. 命名并保存到文件块，用以命名测量子系统中的信号，以及支持保存到 Microsoft® Excel® 文件（仅限独

立版本）

3.7.2 运行仿真

本节包含使用 Blockset 和独立设置的 PLECS 说明。

说明 PLECS Blockset：

1. 在 MATLAB 中打开 TIDA_010054_DAB_Converter_Parameters.m 和 

TIDA_010054_DAB_Converter_Simulation.slx 文件

2. 打开 TIDA_010054_DAB_Converter_Simulation.slx 中的 PLECS 电路
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3. 将 TIDA_010054_DAB_Converter_Models 文件夹添加到散热库中（File → PLECS Preferences → Thermal 
→（按加号））

4. 运行 TIDA_010054_DAB_Converter_Parameters.m 以在 MATLAB 工作区中填充参数。您可以对其进行修

改，以便对不同的工作点进行仿真，或者启用和禁用扩展相移控制（EPS_EN = 1 或 EPS_EN = 0）
5. 通过按 TIDA_010054_DAB_Converter_Simulation.slx 中的“Run”或按 PLECS 仿真平台中的

“Simulation”→“Run”运行仿真

6. 可在 PLECS 电路内的示波器和显示器中监视到仿真情况

说明 PLECS 独立式：

1. 在 PLECS 中打开 TIDA_010054_DAB_standalone.plecs 文件

2. 将 TIDA_010054_DAB_Converter_Models 文件夹添加到散热库中（File → PLECS Preferences → Thermal 
→（按加号））

3. 初始化位于 Simulation → Simulation parameters → Initialization 下面。您可以对其进行修改，以便对不同的

工作点进行仿真，或者启用和禁用扩展相移控制（EPS_EN = 1 或 EPS_EN = 0）
4. 在 PLECS 仿真平台中按“Simulation”→“Run”来运行仿真

5. 可在 PLECS 电路内的示波器和显示器中监视到仿真情况

图 1-1 展示了初级示波器。使用此示波器评估开关波形。

图 1-1 展示了次级示波器。使用此窗口监视输出电压、电流和功率以及输出电压纹波和电容器电流。

图 3-16. PLECS - 初级示波器
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图 3-17. PLECS - 次级示波器

备注
该仿真平台可用于系统级评估。并非所有寄生效应都能准确仿真。仿真结果可能与测量结果不同。
例如，SiC-FET 制造商模型不包含输出电容。因此，可在仿真中在非常轻的负载下实现软开关。轻负载

下的效率与实际测量值不同。
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4 硬件、软件、测试要求和测试结果

4.1 所需的硬件和软件

4.1.1 硬件

本参考设计需要以下硬件：

• 一块 TIDA-010054 电源板

• 一张 TMDSCNCD280039C 控制卡

• USB Type-C® 电缆

• 笔记本电脑

对 DUT 供电和进行评估需要以下测试设备：

• 能够在所需电流下提供 700V–800V 之间的电压的 10kW 直流电源

• 10kW 电阻负载组

• 功率分析仪
• 带插孔连接器的辅助电源，额定值为 12V、2.5A
• 示波器
• 隔离式电压探针和电流探针

4.1.2 软件

本设计中使用了 Code Composer Studio™ 以及 C2000 powerSUITE 和 C2000WARE-DIGITALPOWER-SDK。

该工程的总体结构遵循 C2000Ware-DigitalPower-SDK 结构。对于该设计，<solution> 是“DAB”。解决方案名

称也用作解决方案中使用的所有变量和定义的模块名称。因此，所有变量和函数调用都以 DAB 名称作为前 （例

如，DAB_vSecSensed_pu）。这种命名规则使用户组合不同的解决方案，同时避免命名冲突。

1. “<solution>.c/h”是特定于解决方案并且独立于器件的文件，由核心算法代码组成。

2. “<solution>_board.c/h”特定于电路板并且独立于器件。该文件包含特定于器件的驱动程序，用于运行解决

方案。如果用户想要使用不同的调制方案或不同的器件，除了更改工程中的器件支持文件，用户只需要对这些

文件进行更改。
3. “<solution>-main.c”文件包含该工程的主要框架。该文件由对电路板和解决方案文件的调用（有助于构建系

统框架）以及中断服务例程 (ISR) 和慢速后台任务组成。

4. “<solution>-settings.h”文件用于进行所有工程级设置，例如定义频率、将 PWM 和 ADC 通道映射到控制卡

上的信号。这是一个特定于器件的文件，需要根据器件的不同进行更改。

4.1.2.1 软件入门

1. 安装 Code Composer Studio (CSS)
2. 下载并安装 C2000WARE-DIGITALPOWER-SDK
3. 打开 CCS，转至“Project”→“Import project”，然后浏览至以下文件夹：

C:\ti\c2000\C2000Ware_DigitalPower_SDK_5_02_00_00\solutions\tida_010054\f28003x

\ccs。这时列出 DAB 工程。完成相关步骤以导入该工程。（对于较新版本的 C2000Ware，安装路径可能不

同）
4. 该代码专为 F28003x 控制卡设计。图 1-1 展示了加载的“Project Explorer”视图。在“Project Explorer”窗

口中打开 main.syscfg，选择“Lab”，然后编译，对器件进行编程。

5. 一旦加载完毕，启用实时模式并运行代码。

6. 如需在监视或表达式窗口中添加变量，请点击“View”→“Scripting Console”以打开脚本控制台对话框。在

该控制台的右上角，点击“Open”，然后浏览到位于工程文件夹内的“setupdebugenv_lab1.js”脚本文件。

这将在监视窗口中填入系统调试所需的合适变量。
7. 选择监视窗口中的 Continuous Refresh 按钮，以连续更新控制器中的值。图 1-1 展示了监视窗口。
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图 4-1. Project Explorer 视图

4.1.2.2 引脚配置

表 4-1 显示了 TMS320F280039C 控制卡与 TIDA-010054 基板之间的关键信号连接。

表 4-1. 电路板上用于控制功率级的关键外设

信号名称 说明 连接到控制卡（HSEC 引脚）
PWM-1A 初级侧桥臂 1 高侧驱动 GPIO-00 (49)

PWM-1B 初级侧桥臂 1 低侧驱动 GPIO-01 (51)

PWM-2A 初级侧桥臂 2 高侧驱动 GPIO-02 (53)

PWM-2B 初级侧桥臂 2 高侧驱动 GPIO-03 (55)

PWM-3A 次级侧桥臂 1 高侧驱动 GPIO-04 (50)

PWM-3B 次级侧桥臂 1 低侧驱动 GPIO-05 (52)

PWM-4A 次级侧桥臂 2 高侧驱动 GPIO-06 (54)

PWM-4B 次级侧桥臂 2 高侧驱动 GPIO-07 (56)

I_DC_PRI 初级侧直流电流检测 ADC-C6 (14)

V_DC_PRI 初级侧电压检测 ADC-B11 (24)

I_TANK_PRI 初级槽路电流检测 ADC-B1 (25)

I_TANK_SEC 次级槽路电流检测 ADC-A6 (23)

IMON_MCU 电子保险丝的电流监视器 ADC-C9 (15)

ID_A 硬件识别引脚 ADC-A0 (9)

CLK_MOD 适用于 Δ-Σ 调制器的时钟输出 GPIO8 (57)

CLK_MOD_DELAYED 针对 SDFM 输入的已延迟时钟输出来补偿传播延迟 GPIO9 (59)（输出）
GPIO49 (101)（输入）
GPIO51 (105)（输入）
GPIO55 (102)（输入）

PWM_EN 为 PWM 缓冲器启用 GPIO12 (58)

FAN_CTL 风扇使能引脚 GPIO13 (60)

Prof_GPIO1 性能评测引脚 1 GPIO14 (62)

Prof_GPIO2 性能评测引脚 2 GPIO15 (64)

TEMP_SENSE 用于温度检测的 ECap 输入（未实现） GPIO20 (68)
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表 4-1. 电路板上用于控制功率级的关键外设 （续）
信号名称 说明 连接到控制卡（HSEC 引脚）
MUX_A0 TMUX1204 用于选择温度信号的控制信号 1（未实

现）
GPIO21 (70)

MUX_A1 TMUX1204 用于选择温度信号的控制信号 2（未实

现）
GPIO22(72)

DESAT_PRI 来自初级侧栅极驱动器的 DESAT 信号 GPIO10 (61)

DESAT_SEC 来自次级侧栅极驱动器的 DESAT 信号 GPIO16 (67)

RST_MCU 来自 MCU 的复位信号（未使用） GPIO11 (63)

RDY 来自栅极驱动器的电源正常状态指示器 GPIO17 (69)

FLT_PRI 初级侧电流传感器的故障信号 GPIO26 (79)

FLT_SEC 次级侧电流传感器的故障信号 GPIO27 (81)

DOUT_V_BATT_SEC SDFM 输入 D1 GPIO48 (99)

DOUT_V_DC_SEC SDFM 输入 D2 GPIO50 (101)

DOUT_I_DC_SEC SDFM 输入 D4 GPIO54 (100)

4.1.2.3 PWM 配置

上-下计数模式用于为双有源电桥的初级桥臂和次级桥臂生成 PWM。为了使用高分辨率 PWM，PRIM_LEG1_H 
PWM 脉冲以周期事件为中心，并且时基配置为上-下计数模式。然后，为互补开关生成具有高分辨率死区时间的

互补脉冲。在桥臂 1 与桥臂 2 之间，存在 180 度的相移用于全桥运行。这是通过使用 PWM 模块上的特性交换 

xA 和 xB 输出来实现的。此应用的 PWM 频率是 100kHz。在上-下计数模式中，TBPRD 寄存器设置为值 500。

占空比值加载到 EPWM 时基的 CMPA 寄存器中，并配置为生成 50% 占空比。动作限定符模块输出控制比较 A 事
件上的 PWM 输出所需的动作。Type-4 PWM 上的全局链接机制用于减少更新寄存器并启用高频运行所需的周期

数。例如，DAB_HAL_setupPWM() 函数中的下述代码链接所有 PWM 桥臂的 TBPRD 寄存器。

借助此链接，对 PRIM_LEG1 TBPRD 寄存器的单次写入就会将该值写入 PRIM_LEG2、SEC_LEG1 和 

SEC_LEG2 中。

图 4-2. PWM 写入

4.1.2.4 高分辨率相移配置

使用的高分辨率特性：

• 高分辨率相移
• 高分辨率死区
• 高分辨率占空比 → 不可用，CTMODEB 设为 1
• 高分辨率周期 → 不可用，CTMODEB 设为 1

次级侧的 PWM 脉冲相对于初级侧的 PWM 脉冲发生相移。控制相移可以实现初级侧与次级侧之间的功率传输，
反之亦然。传输的最大功率对双有源电桥中的相移值非常敏感。一个较小的串联电感器能够以较小的相移值实现
最大功率传输。由于相移的变化范围很小，因此准确控制需要精细地递增和递减相位阶跃。使用 F28004x 的高分

辨率特性实现相位控制。ISR1 中的函数 DAB_calculatePWMDutyPeriodPhaseShiftTicks() 负责计算电

压和电流模式控制所需的高分辨率相位控制。这有助于平滑地处理负载突变，而不会导致电流波形中出现巨大的

过冲/瞬态现像。
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图 4-3. PWM 函数 1
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图 4-4. PWM 函数 2

更新变量 DAB_phaseSyncPrimToSecCountDirection 以控制电流的正向模式或反向模式。

RED

CMPA

FED

ISR1 Trig 

Writes from ISR1 to 

the global load 

registers will come 

in effect here

RED

FED

TBPRD(1 ± dutyPrim)

PWM 

Sync

PRIM_LEG1_PWM 

PRIM_LEG2_PWM

TIMEBASE

CMPC= Phase

Accounting for ISR 

latency the ISR will 

be services in this 

zone, where the 

global link registers 

are written to

TBPRD ± Offset  is 

used to offset for 

ISR latency 

RED

FED

Q1, Q4

Q2, Q3

SEC_LEG1_PWM

SEC_LEG2_PWM
TIMEBASE

Q5, Q8

Q6, Q7

图 4-5. PWM 配置
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4.1.2.5 ADC 配置

在 dab_main.c 中使用函数 DAB_HAL_setupADC() 完成 ADC 的配置。基准电压、时钟预分频以及电压和电流

信号的 SOC（转换启动）设置均在此处完成。EPWM1 的转换启动 (SOC) 信号生成 ADC 的触发。在 

dab_main.c 文件中的 DAB_HAL_setupTrigForADC() 函数内完成此配置。将 HSEC 控制卡引脚连接器映射

到控制卡的所有其他设置都在 dab_settings.h 文件中完成。

4.1.2.6 ISR 结构

DAB 工程由两个 ISR（ISR1 和 ISR2）组成，其中 ISR1 速度最快且不可嵌套。ISR1 保留用于控制环路和 PWM 
更新。ISR1 由 PRIM_LEG1_PWM_BASE → EPWM_INT_TBCTR_U_CMPC 事件触发。

以下是与此 ISR 相关的宏定义：

#define DAB_ISR1_PERIPHERAL_TRIG_BASE DAB_PRIM_LEG1_PWM_BASE
#define DAB_ISR1_TRIG INT_EPWM1
#define DAB_ISR1_PIE_GROUP INTERRUPT_ACK_GROUP3
#define DAB_ISR1_TRIG_CLA CLA_TRIGGER_EPWM1INT

ISR2 由 CPU 计时器 INT 触发，而 CPU 计时器 INT 由 CPU 计时器的溢出发起。ISR2 为命令的参考信号运行压

摆率函数。

#define DAB_ISR2_TIMEBASE CLLLC_TASKC_CPUTIMER_BASE
#define DAB_ISR2_TRIG INT_TINT2

另外，CPU 计时器用于触发慢速后台任务（这些任务均不由中断驱动，而是采用轮询方式）。“A”任务在 

TASKA_FREQ（即 100Hz）时触发。必须以此速率调用 SFRA GUI。以这一速率执行一个任务 A1。“B”任务

在 TASKB_FREQ（即 10Hz）时触发。这些任务用于一些基本的 LED 切换和非时间关键型状态机项目。B1、B2 
和 B3 这三个任务都是以此为目的。

图 1-1 展示了 ISR 软件图。

备注
当前软件中未使用 EMAVG_RUN 函数。
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DAB_pwmFrequency_Hz

PWMSYSCLOCK_FREQ / 

(DAB_pwmPeriodMax_ticks * 

DAB_pwmPeriod_pu)

DAB_calculatePWMDu

tyPeriodPhaseShiftTick

s()

DAB_pwmDutyPrimRef_pu

DAB_pwmDutyPrim_pu

DAB_pwmDutySecRef_pu

DAB_pwmDutySec_pu

DAB_pwmPhaseShiftPrimSecRef_ns

DAB_pwmPhaseShiftPrimSec_ns

DAB_pwmPeriod_ticks

DAB_pwmDutyAPrim_ticks

DAB_pwmDutyASec_ticks

DAB_pwmDutyBSec_ticks

DAB_pwmPhaseShiftPrimSec_ticks

DAB_HAL_updateP

WMDutyPeriodPhas

eShift()

Variables shown in red are the only 

ones that must be changed or 

observed from the watch window, 

these are declared as volatiles

DAB_pwmDeadBandREDPrimRef_ns

DAB_pwmDeadBandFEDPrimRef_ns

DAB_pwmDeadBandREDSecRef_ns

DAB_pwmDeadBandFEDSecRef_ns

DAB_calculatePWMDe

adBandPrimTicks()
DAB_HAL_updatePWMDe

adBandPrim()

DAB_pwmDeadBandREDPrim_ticks

DAB_pwmDeadBandFEDPrim_ticks

DAB_pwmDeadBandREDSec_ticks

DAB_pwmDeadBandFEDSec_ticks

DAB_HAL_updatePWMDe

adBandSec()
DAB_calculatePWMDe

adBandSecTicks()

VSEC

ISEC

ISEC_TANK

VPRIM

IPRIM

DAB_vPrimSensed_pu

DAB_iPrimSensed_pu

DAB_vSecSensed_pu

DAB_iSecSensed_pu

DAB_pwmPeriod_pu

DAB_pwmPeriodMax_ticks

DAB_readSensedSignals()

ISR1

ISR2

DAB_vSecRef_pu DAB_vSecRef_Volts1 / (DAB_VSEC_MAX_SENSE)

DAB_VOLTS_PER_SECOND_SLEW

GV_RUN

Gv

DAB_vSecRefSlewed_pu
DAB_closeGvLoop==2

DAB_closeGiLoop !=1 &&

DAB_closeGvLoop !=1

DAB_pwmPeriodRef_pu

EMAVG_RUN

EMAVG_RUN

DAB_VSEC_OPTIMAL_RANGE

DAB_ISEC_MAX_SENSE

DAB_vPrimSensed_Volts

DAB_iPrimSensed_Amps

EMAVG_RUN

EMAVG_RUN

DAB_IPRIM_MAX_SENSE

DAB_VPRIM_MAX_SENSE

DAB_iPrimSensed_Amps

DAB_vPrimSensed_Volts

 

DAB_HAL_clearPWMTripF

lags()
DAB_clearTrip ==1

图 4-6. 软件图

备注
对于扩展相移控制，引入了变量 DAB_pwmEPSAlphaPRef_pu、DAB_pwmEPSAlphaP_pu、

DAB_pwmEPSAlphaSRef_pu、DAB_pwmEPSAlphaS_pu、

DAB_pwmEPSPhaseShift_P1_P2_ticks、DAB_pwmEPSPhaseShift_P1_S1_ticks 和 

DAB_pwmEPSPhaseShift_P1_S2_ticks。函数 DAB_calculatePWMPhaseShift 周期和 

DAB_HAL_ipdatePWMDutyPeriodPhaseShift() 会被相应地修改。

4.2 测试设置

如需测试本参考设计的效率，请使用图 1-1 所示的设置。

• 10kW 直流电源：800V，12.5A
• 10kW 电阻负载：500V，20A
• 提供 12V、2.5A 的辅助电源

• TMDSCNCD280039C 控制卡

• 功率分析仪
• 带有隔离式探针的示波器，用于测量电压和电流

• 12V 风扇为散热器提供足够的空气流量

www.ti.com.cn 硬件、软件、测试要求和测试结果

ZHCU677E – JUNE 2019 – REVISED APRIL 2024
提交文档反馈

适用于 3 级电动汽车充电站的双向双有源电桥参考设计 43

English Document: TIDUES0
Copyright © 2024 Texas Instruments Incorporated

https://www.ti.com.cn
https://www.ti.com.cn/cn/lit/pdf/ZHCU677
https://www.ti.com/feedbackform/techdocfeedback?litnum=ZHCU677E&partnum=TIDA-010054
https://www.ti.com/lit/pdf/TIDUES0


Power Supply

10kW

800V

TIDA-010054

under test

Auxiliary supply

12V

2.5A

Resistive Load

10kW

Power Analyzer

Primary Side Secondary Side

Input Voltage 

and Current

Output Voltage and 

Current

Code Composer Studio 

IDE

USBPower Jack

图 4-7. 测试设置

图 4-8. 电路板图片
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在为电路板供电进行开环测试之前，请按照以下步骤来设置电路板：

1. 将终端 J11 和 J13 连接到输入电源，并将终端 J12 和 J14 连接到输出负载组。使用 4mm2 布线来完成这些连

接，以便可以处理较高的电流而不会快速发热。

2. 使用 PJ-002 母连接器将辅助电源连接到终端 J15，以便为控制器、栅极驱动器和检测电路供电

电路板中的中央有切断区域，用于安装变压器。使用 M3 螺钉将变压器直接连接到电路板上。安装变压器时请多

加注意，确保初级侧和次级侧没有互换。

控制卡通过笔记本电脑的 USB 连接进行编程以便在 100kHz 的频率下生成 PWM 脉冲。一旦编程完毕，辅助电源

则设置为 12V。不要在端子 J2 和 J4 上施加电压。在此状态下，12V 电源轨上的电流消耗应约为 700mA。继电器

关闭且风扇启用后，此功耗会增加。

将两个 12V 风扇连接到风扇连接器 J1 和 J3。极性在 PCB 和原理图中进行了标记。

按照实验 1 到实验 7 操作，熟悉该设计并提供正确的操作。

连接器终端 功能 注释

J11–J13 输入高压电源 能够提供 10kW 功率的 800V 直流电源

J12–J14 输出负载终端 10kW 电阻负载组连接在此处

J15 用于栅极驱动器、控制卡和检测电路的辅助电源 限制为 700mA 的 15V 直流电源电流

J2 TMDSCNCD280049C 控制卡 将控制卡插入此处

J6 CAN 连接器 当前版本中不支持

J1、J3 风扇连接器 用于冷却的 12V 风扇连接器
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4.3 PowerSUITE GUI
本工程使用 PowerSUITE GUI 来快速配置测试规格。图 1-1 提供了有关 PowerSUITE GUI 的详细说明。打开 

main.syscfg 可配置运行各种实验活动所需的参数。

图 4-9. PowerSUITE GUI 说明
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4.4 实验

本参考设计的软件由五个实验组成。这些测试简化了系统启动和设计。
表 4-2. 实验汇总

实验 实验用于检查什么？ 注释

1 PWM 检查，功率流初级→次级 验证从初级到次级的功率传输。检查 PWM 频
率，另外还检查相移是否正常

2 PWM 检查，ADC 检查，保护检查 测量用于电压和电流的开环装置。检查电压和

电流传感器的反馈。在保护功能启用且跳闸标

志设置期间，确保禁用 PWM 信号。

检查变量 DAB_clearTrip

3 电压闭环 - Vsec 运行电压模式补偿器。从 SFRA 获取装置的开

环传递函数。在补偿器设计工具中设计装置的

补偿器。

DF22 补偿器已实现。反馈变量为

DAB_vSecSensed_pu

4 电流闭环 → Isec 运行电流模式补偿器。从 SFRA 获取装置的开

环传递函数。在补偿器设计工具中设计装置的

补偿器。

PI 补偿器已实现。反馈变量为

DAB_iSecSensed_pu

5 反向功率流次级→初级 验证从次级到初级的功率传输。检查 PWM 频
率，另外还检查相移是否正常

6 反向功率流次级→初级闭合电压环路 运行电压模式补偿器。从 SFRA 获取装置的开

环传递函数。在补偿器设计工具中设计装置的

补偿器。

DF22 补偿器已实现。反馈变量为

DAB_vPriSensed_pu

7 反向功率流次级→初级闭合电流环路 运行电流模式补偿器。从 SFRA 获取装置的开

环传递函数。在补偿器设计工具中设计装置的

补偿器。

PI 补偿器已实现。反馈变量为

DAB_iPriSensed_pu

www.ti.com.cn 硬件、软件、测试要求和测试结果

ZHCU677E – JUNE 2019 – REVISED APRIL 2024
提交文档反馈

适用于 3 级电动汽车充电站的双向双有源电桥参考设计 47

English Document: TIDUES0
Copyright © 2024 Texas Instruments Incorporated

https://www.ti.com.cn
https://www.ti.com.cn/cn/lit/pdf/ZHCU677
https://www.ti.com/feedbackform/techdocfeedback?litnum=ZHCU677E&partnum=TIDA-010054
https://www.ti.com/lit/pdf/TIDUES0


4.4.1 实验 1

通过从 PowerSUITE GUI 的 Project Options 下拉菜单中选择 Lab 1: Open Loop PWM ，对工程进行编译。此实

验旨在验证 PWM 输出，并可以使用 TIDA-010054 硬件 (HW) 或者使用带扩展坞的 F2804X 控制卡直接检查。

通过点击 CCS 中的绿色运行按钮，运行工程。

图 4-10. 运行 CCS

通过在脚本控制台中加载 JavaScript® setupdebugenv_lab1.js，在监视窗口中填充所需的变量。

图 4-11. 加载实验
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图 4-12. 选择实验

1. 运行该脚本后，在监视窗口中填充图 1-1 中所示的变量。

图 4-13. 监视窗口

2. 在表达式窗口右上角启用 Continuous refresh。
3. 通过将“1”写入 DAB_clearTrip 变量，启用 PWM。（此变量在写入后及正常工作期间复位为零。）
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• 实验 1 的通过标准

连接 PWM1A (Q1)、PWM1B (Q2)、PWM3A(Q5) 和 PWM3B (Q6) 上的探针。

1A 和 1B 为互补对，3A 与具有指定相移的 1A 同步，且相移由变量 DAB_pwmPhaseShiftPrimSecRef_pu 控
制。

请检查以下各项：

1. 频率为 100kHz

PWM1A（黄色）、PWM1B（红色）、PWM3A（蓝色）、PWM3B（绿色）

图 4-14. 100kHz PWM
2. 现在将相移更改为 0.05ns → 500ns，以查看更多可监视的相移。

图 4-15. 相移 500ns
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3. 在示波器上验证相移是否与指定的值匹配。为了验证高分辨率运行，请选择不与系统时钟保持一致的值，
这意味着不能被 10ns 整除。在图 1-1 和图 1-1 中，相移由示波器测量，其中对于 500ns 设定点，相称大

概为 500ns，对于 502ns 设定点，相移大概为 502ns，小幅抖动大概为 1ns 至 2ns 的小幅抖动可能，可以

是测量误差。

小心
不建议在 0.45pu 以上运行相移。

使用示波器的数学通道测量相移。橙色波形为 PWM3B – PWM1B。宽度等于相移。测得的相移 = 499.8ns。

图 4-16. 高分辨率相移 500ns

使用示波器的数学通道测量相移。橙色波形为 PWM3B – PWM1B。宽度等于相移。测得的相移 = 501.6ns。

图 4-17. 高分辨率相移 502ns
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4. 将 PWM 探针更改为 PWM1A、PWM1B、PWM2A 和 PWM2B。
– 验证 PWM1A 和 2B 是否同步且同相

– 验证 PWM1B 和 2A 是否同步且同相

PWM1A（黄色）、PWM1B（红色）、PWM2A（绿色）、PWM2B（蓝色）

图 4-18. PWM 同步

5. 当次级侧 PWM 的相移发生改变时，验证它们是否保持同步且同相。

PWM1A（黄色）、PWM1B（红色）、PWM2A（绿色）、PWM2B（蓝色）

图 4-19. PWM 同步但存在相移
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4.4.2 实验 2

在实验 2 的构建中，电路板会以开环方式和指定的频率 (100kHz) 和相移接受激励。相移可以通过监视窗口更改。

相移由 DAB_pwmPhaseShiftPrimSec_pu 变量控制。该构建验证了功率级反馈值的检测、PWM 栅极驱动器的

运行和硬件保护功能，并确保没有硬件问题。此外，还校准了构建中的输入和输出电压检测。有关硬件测试设

置，请参阅节 4.2。

• 实验 2 的软件设置

在构建过程中，在 settings.h 文件中设置了以下定义。可以从 PowerSUITE GUI 的 Project Options 下拉菜
单中选择 Lab 2: Open Loop PWM with Protection 来定义该设置。

图 4-20. 实验 2 软件设置

1. 通过点击 CCS 中的绿色运行按钮，运行工程。

2. 通过在脚本控制台中加载 JavaScript setupdebugenv_lab2.js，在监视窗口中填充所需的变量。

图 4-21. 实验 2 监视视图配置

3. 在监视视图中，检查 DAB_vPrimSensed_Volts、DAB_iPrimSensed_Amps、

DAB_vSecSensed_Volts 和 DAB_iSecSensed_Amps 变量是否定期更新。
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备注
由于此时未通电，因此这些变量接近于零。

• 继电器和风扇验证

– 在空闲状态下，辅助 12V 电源需要消耗约 700mA 电流。

– 将“1”写入 DAB_enableRelay。通常会听到典型的咔嗒声，电流消耗需要增加至大约 1.14A。
– 将“1”写入 DAB_enableFan。风扇开始转动，电流消耗增加至 1.43A（此处使用两个 

CFM6015V-154-362 风扇）。

• 功率传输验证

– 施加低输入电压（例如 50V）
– 通过将“1”写入 DAB_CLEAR Trip 来清除 PWM 跳变

– 确认电压和电流出现在输出端
– 可以通过修改 DAB_pwmPhaseShuftPrimSecRef_pu 来改变相移

默认情况下，DAB_pwmPhaseShiftPrimSec_pu 变量设置为 0.02。以 0.002pu 的步长缓慢地改变此相移，
并监视转换器输出的电压变化。确保勿将相移增加到太高，因为这会导致输出电压超过输入电压，并导致在施

加最大电压时出现 MOSFET 击穿。

• 保护验证

在进行实际的高电压和高功率测试之前，请验证保护功能。也可以在低电压（例如 50V 输入）下进行验证。可

以从 PowerSUITE GUI 修改过流和过压保护的限值，请参阅图 1-1。

1. 初级过流保护：
a. 将 IPRIM_TRIP 设置为 1A
b. 连接 50V 输入电压

c. 启用继电器并清除 PWM
d. 逐步增加相移，以增加初级电流

e. 超过 1A 后监视跳闸

初级 - 过流保护，设定的限值 = 1A

图 4-22. 实验 2 - 初级过流保护

2. 初级槽路过流保护

a. 将 IPRIM_TANK_TRIP 设置为 1.5A
b. 连接 50V 输入电压

c. 启用继电器并清除 PWM
d. 逐步增加相移，以增加初级槽路电流

e. 超过 1.5A 后监视跳闸
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初级 - 槽路过流保护，设定的限值 = 1.5A

图 4-23. 实验 2 - 初级槽路过流保护

3. 次级过流保护

a. 将 ISEC_TRIP 设置为 1.5A
b. 连接 50V 输入电压

c. 启用继电器并清除 PWM
d. 逐步增加相移以增加次级电流

e. 超过 1.5A 后监视跳闸

图 4-24. 实验 2 - 次级过流保护

4. 次级过压保护

a. 将 VSEC_TRIP 设置为 40V
b. 连接 50V 输入电压

c. 启用继电器并清除 PWM
d. 逐步增加相移以增加次级电压

e. 越过 40V 后监视跳闸
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图 4-25. 实验 2 - 过压保护

上述波形显示了比较器子系统在故障事件期间关断了 PWM。通过变量 DAB_tripFlag，可以在监视窗口

中显示故障类型，请参阅图 1-1。通过在下拉菜单中选择 noTrip 可以复位跳变信号，而通过将“1”写入 

DAB_clearTrip 变量重新启用 PWM。在重新启用 PWM 之前，确保故障条件已清除。

图 4-26. 表达式窗口中的触发指示

• 测量电压环路的 SFRA 装置

1. SFRA 集成在 C2000Ware-DigitalPower-SDK 套件中，用于测量装置响应，然后可以用于设计补偿器。

通过点击 SFRA 图标，运行 SFRA。SFRA GUI 随即打开。

2. 在 SFRA GUI 上选择器件对应的各个选项；例如，对于 F280039，请选择浮点。点击 Setup Connection 
按钮。在弹出窗口中，取消选中“boot-on-connect”选项，然后选择合适的 COM 端口。选择 OK 按钮。

返回到 SFRA GUI，然后点击 Connect 按钮。

3. SFRA GUI 将连接到器件。现在可以通过点击 Start Sweep 按钮启动 SFRA 扫描。完成完整的 SFRA 扫描

需要几分钟的时间。查看 SFRA GUI 上进度条中的活动或检查控制卡背面上的蓝色 LED 的闪烁情况来指

示 UART 活动。
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测试条件：VIN = 800V、VOUT = 500V、IOUT = 10A，相移 = 0.047pu。
由于输出电压测量中存在噪声且受控体增益较小，因此在较高频率下预计会出现相位图中的噪声。

图 4-27. 实验 2 用于开路电压环路测试的 SFRA 装置图

4. 频率响应数据 SFRA.csv 保存在 SFRA 数据文件夹下的工程文件夹中，并以 SFRA 运行的时间为时间

戳。SFRA 可以在不同的频率设定点下运行以覆盖系统的工作范围。通过补偿设计器使用这些测量图设计

补偿器。补偿设计器可从 main.syscfg GUI 打开。

在 ISR1 内，SFRA 注入同相位的微小信号扰动并监视检测到的输出电压变化。dab.h 文件中的以下几行代

码用于注入和收集 SFRA 信号。

图 4-28. 实验 2 用于 SFRA 信号注入的代码

• 测量电流环路的 SFRA 装置

1. 按照电压环路中的相同步骤，开始进行电流环路的 SFRA 测量。

2. 在 SFRA 选项卡下的 PowerSUITE GUI 中，在运行 SFRA 电流环路之前选择 current。

图 4-29. 实验 2 代码定义 SFRA 电流环路

3. 在 ISR1 内，SFRA 注入同相位的微小信号扰动并监视检测到的输出电流变化。dab.h 文件中的以下几行代

码用于注入和收集 SFRA 信号。
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图 4-30. 实验 2 用于 SFRA 信号注入的代码

4. 从 SFRA GUI 测量装置响应。开环响应和装置响应存储在名为 SFRA.csv 的文件中。使用此文件调整电流

环路的补偿器。

测试条件：VIN = 800V，VOUT = 500V，IOUT = 10A，相移 = 0.047pu

图 4-31. 实验 2 用于开路电压环路测试的 SFRA 装置图
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4.4.3 实验 3

在实验 3 中，转换器以次级电压闭环配置 (DAB_vSecSensed_Volts) 运行。

此实验运行电压模式比较器，从 SFRA 获取装置的开环传递函数，并在补偿器设计工具中为装置运行设计补偿

器。

启动补偿设计器，提示选择有效的 SFRA 数据文件。将实验 2 中运行的 SFRA 数据导入补偿设计器来设计 

2P2Zcompensator。在此迭代设计过程中保持更大的裕度，以确保环路闭合时，系统是稳定的。在软件中对下述

系数值进行硬编码。补偿设计器 GUI 提供了有关环路稳定性、增益裕度、相位裕度和环路带宽的信息。可以在补

偿设计器 GUI 中修改系数。

#define DAB_GV_2P2Z_A1 ((float32_t) -1.8756666)
#define DAB_GV_2P2Z_A2 ((float32_t) 0.8756666)
#define DAB_GV_2P2Z_B0 (float32_t) 1.4329852)
#define DAB_GV_2P2Z_B1 ((float32_t) -2.7994568)
#define DAB_GV_2P2Z_B2 (float32_t) 1.3664965)

• 用于实验 3（闭环电压环路 - 次级）的测试设置

通过从 PowerSUITE GUI 的 Project Options 下拉菜单中选择 Lab 3: Closed Loop Voltage with Resistive 
Load ，对工程进行编译。确保按照工作条件设置电流和电压限制。

#if DAB_LAB == 3
#define DAB_CONTROL_RUNNING_ON C28X_CORE
#define DAB_POWER_FLOW DAB_POWER_FLOW_PRIM_SEC
#define DAB_INCR_BUILD DAB_CLOSED_LOOP_BUILD
#define DAB_TEST_SETUP DAB_TEST_SETUP_RES_LOAD
#define DAB_PROTECTION DAB_PROTECTION_ENABLED
#define DAB_CONTROL_MODE DAB_VOLTAGE_MODE
#define DAB_SFRA_TYPE 2
#define DAB_SFRA_AMPLITUDE (float32_t)DAB_SFRA_INJECTION_AMPLITUDE_LEVEL2
#endif

使用以下步骤来运行电压闭环：

1. 通过点击 CCS 中的绿色运行按钮，运行工程。

2. 通过在脚本控制台中加载 JavaScript setupdebugenv_lab3.js，在监视窗口中填充所需的变量。

图 4-32. 实验 3 - 监视视图配置

3. 通过将“1”写入 DAB_enableFan 和 DAB_enableRelay 来启用风扇和继电器。
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4. 通过将“1”写入 DAB_clearTrip 变量，启用 PWM。

5. 在监视视图中，检查 DAB_vPrimSensed_Volts、DAB_iPrimSensed_Amps、

DAB_vSecSensed_Volts 和 DAB_iSecSensed_Amps 变量是否定期更新。

6. 通过写入 DAB_vSecRef_Volts，设置输出电压（本例中为 50Vdc）。

7. 通过将“1”写入 DAB_closeGvLoop 变量，启用闭环操作。控制器会根据工作条件自动调节相移，从而

生成与 DAB_vSecRef_Volts 匹配的次级输出电压。

备注
在该软件中，作为安全预防措施，最大相移限制为 0.13。调节初级电压，使其保持在相移限制内并

仍能生成所需的次级电压。
8. 缓慢地增加 VPRIM 直流输入电压并相应地调节 DAB_vSecRef_Volts，以达到所需的工作点。

9. 通过将 DAB_vSecRef_Volts 从 400V 改变为 500V，以测试闭环操作。监视到 

DAB_vSecSensed_Volts 会跟踪此命令参考。

图 4-33. 实验 3 - 闭合电压环路表达式窗口

10. 通过在 DAB_pwmSwState.pwmSwState 下拉列表中选择相应的变量，可以在单相移 SPS 和扩展相移 

EPS 之间更改控制方案。

初级侧开关节点电压（绿色）、次级侧开关节点电压（红色）、电感器电流（黄色）
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测试条件：VIN = 800V，VOUT = 450V，IOUT = 6.5A

图 4-34. 实验 3 - 单相移控制 (SPS) 中的波形

图 1-1 展示了在这种情况下，次级侧在 SPS 控制下是硬开关。

初级侧开关节点电压（绿色）、次级侧开关节点电压（红色）、电感器电流（黄色）
测试条件：VIN = 800V，VOUT = 450V，IOUT = 6.5A

图 4-35. 实验 3 - 扩展相移控制 (EPS) 中的波形

初级侧通过 EPS 控制引入的附加相移如图 1-1 所示。这里，初级侧和次级侧均为软开关。
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• 闭环电压的频率响应

1. 通过点击 SFRA 图标，运行 SFRA。SFRA GUI 随即打开。

2. 在 SFRA GUI 上选择器件对应的各个选项；例如，对于 F280039，请选择浮点。点击 Setup Connection 
按钮。在弹出窗口中，取消选中“boot-on-connect”选项，然后选择合适的 COM 端口。选择 OK 按钮。

返回到 SFRA GUI，然后点击 Connect 按钮。

3. SFRA GUI 将连接到器件。现在可以通过点击 Start Sweep 按钮启动 SFRA 扫描。完整的 SFRA 扫描需要

几分钟才能完成。查看 SFRA GUI 上进度条中的活动或检查控制卡背面上的蓝色 LED 的闪烁情况来指示 

UART 活动。

图 1-1 中的波特图是使用 DF22 补偿器采集的。

测试条件：VIN= 800V，VOUT = 500V，IOUT = 10A，SFRA 振幅 = 0.002

图 4-36. 实验 3 - 用于闭环电压环路的 SFRA 开环图
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4.4.4 实验 4

• 用于实验 4（闭环电流环路 - Isec）的测试设置

通过从 PowerSUITE GUI 的 Project Options 下拉菜单中选择 Lab 4: Closed Loop Current with Resistive 
Load，对工程进行编译。确保按照工作条件设置电流和电压限制。

#if DAB_LAB == 4
#define DAB_CONTROL_RUNNING_ON C28X_CORE
#define DAB_POWER_FLOW DAB_POWER_FLOW_PRIM_SEC
#define DAB_INCR_BUILD DAB_CLOSED_LOOP_BUILD
#define DAB_TEST_SETUP DAB_TEST_SETUP_RES_LOAD
#define DAB_PROTECTION DAB_PROTECTION_ENABLED
#define DAB_CONTROL_MODE DAB_CURRENT_MODE
#define DAB_SFRA_TYPE 1
#define DAB_SFRA_AMPLITUDE (float32_t)DAB_SFRA_INJECTION_AMPLITUDE_LEVEL1
#endif

1. 通过点击 CCS 中的绿色运行按钮，运行工程。

2. 通过在脚本控制台中加载 JavaScript setupdebugenv_lab4.js，在监视窗口中填充所需的变量。

图 4-37. 实验 4 监视视图配置

3. 通过将“1”写入 DAB_enableFan 和 DAB_enableRelay 来启用风扇和继电器。

4. 通过将“1”写入 DAB_clearTrip 变量，启用 PWM。

5. 在监视视图中，检查 DAB_vPrimSensed_Volts、DAB_iPrimSensed_Amps、

DAB_vSecSensed_Volts 和 DAB_iSecSensed_Amps 变量是否定期更新。

6. 通过写入 DAB_iSecRef_Amps，设置输出电流（本例中为 1Adc）。

7. 通过将“1”写入 DAB_closeGiLoop 变量，启用闭环操作。控制器会根据工作条件自动调节相移，从而

生成与 DAB_iSecRef_Amps 匹配的次级输出电流。

备注
在该软件中，作为安全预防措施，最大相移限制为 0.13。请调节初级电压，以使其保持在相移限制

内并仍能生成所需的次级电流。
8. 现在，缓慢地增加 VPRIM 直流输入电压并相应地调节 DAB_iSecRef_Amps，以达到所需的工作点。
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图 4-38. 实验 4 - 表达式窗口闭合电流环路

小心
确保根据输出负载将次级电流限制为安全值。高阻抗负载会导致产生危险的次级电压，进而损坏电

路板。确保启用了次级过压保护并且阈值已设置为安全值。

#define DAB_PROTECTION DAB_PROTECTION_ENABLED
#define DAB_VSEC_TRIP_LIMIT ((float32_t)500)
#define DAB_BOARD_PROTECTION_VSEC_OVERVOLTAGE 1

• 闭环电流的频率响应

1. 通过点击 SFRA 图标，运行 SFRA。SFRA GUI 随即打开。

2. 在 SFRA GUI 上选择器件对应的各个选项；例如，对于 F280039，请选择浮点。点击 Setup Connection 
按钮。在弹出窗口中，取消选中“boot-on-connect”选项，然后选择合适的 COM 端口。选择 OK 按钮。

返回到 SFRA GUI，然后点击 Connect。
3. SFRA GUI 将连接到器件。现在可以通过点击 Start Sweep 启动 SFRA 扫描。完整的 SFRA 扫描需要几分

钟才能完成。查看 SFRA GUI 上进度条中的活动或检查控制卡背面上的蓝色 LED 的闪烁情况来指示 

UART 活动。

图 1-1 中的波特图是使用 PI 补偿器（增益为 0.5）采集的。
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测试条件：VIN= 800V，VOUT = 500V，IOUT = 10A，SFRA 振幅 = 0.002

图 4-39. 实验 4 用于闭环电流环路的 SFRA 开环图

#define DAB_GI_KP (float32_t) 0.5
#define DAB_GI_KI (float32_t) 0.0063030
#define DAB_GI_UMAX (float32_t) 0.13
#define DAB_GI_UMIN (float32_t) -0.13
#define DAB_GI_IMAX (float32_t) 2.0
#define DAB_GI_IMIN (float32_t) -2.0
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4.4.5 实验 5

图 1-1 展示了实验 5（开环电压 - 反向功率流）的测试设置。

在此设置中，直流电源连接到次级侧，而电阻负载连接到初级侧。

Resistive Load

10kW

TIDA-010054

under test

Auxiliary supply

12V

2.5A

Power Supply

10kW

500V

Power Analyzer

Primary Side Secondary Side

Input Voltage 

and Current

Output Voltage and 

Current

Code Composer Studio 

IDE

USBPower Jack

图 4-40. 实验 5 测试设置

通过从 PowerSUITE GUI 的 Project Options 下拉菜单中选择 Lab 5: Open Loop PWM, Sec to Prim Power 
Flow，对工程进行编译。确保按照工作条件设置电流和电压限制。

#if DAB_LAB == 5
#define DAB_CONTROL_RUNNING_ON C28X_CORE
#define DAB_POWER_FLOW DAB_POWER_FLOW_SEC_PRI
#define DAB_INCR_BUILD DAB_OPEN_LOOP_BUILD
#define DAB_CONTROL_MODE  DAB_VOLTAGE_MODE
#define DAB_TEST_SETUP DAB_TEST_SETUP_RES_LOAD
#define DAB_PROTECTION DAB_PROTECTION_ENABLED
#define DAB_SFRA_TYPE  2
#define DAB_SFRA_AMPLITUDE (float32_t)DAB_SFRA_INJECTION_AMPLITUDE_LEVEL2
#endif

1. 通过点击 CCS 中的绿色运行按钮，运行工程。

2. 通过在脚本控制台中加载 JavaScript setupdebugenv_lab5.js，在监视窗口中填充所需的变量。
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图 4-41. 实验 5 - 监视视图

3. 通过将“1”写入 DAB_enableFan 和 DAB_enableRelay 来启用风扇和继电器。

4. 通过将“1”写入 DAB_clearTrip 变量，启用 PWM。

5. 通过写入 DAB_pwmPhaseShiftPrimSec_pu，以 0.002pu 的步长缓慢地改变相移，并监视转换器输出的电

压变化。

备注
相移值中的负号是反向功率流所需的。

6. 在增加电压之前，验证初级侧过压保护。

7. 将 VPRIM_TRIP 设置为 50V。
8. 缓慢增大（负）相移，并在电压达到 50V 时监视跳变。

图 4-42. 实验 5 - 初级侧过压保护

9. 验证过压保护是否正常工作后，将 VPRIM_TRIP 设置回 1000V。
10. 现在，次级侧上的电压可以缓慢增大，并且可以修改相移，从而监视初级侧电压和电流。
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图 4-43. 实验 5 表达式窗口高电压

• 测量电压环路的 SFRA 装置

1. 按照与实验 2 中相同的说明操作。

测试条件：VIN = 350V、VOUT = 550V、IOUT = 9A。
VIN 是指次级侧电压，VOUT 和 IOUT 是指初级侧电压和反向电流 (DAB_IprimSensed_Amps = –9A)。

图 4-44. 实验 5 - 用于开路电压环路测试的 SFRA 装置图
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• 测量电流环路的 SFRA 装置

1. 执行与实验 2 中相同的步骤。

测试条件：VIN = 350V、VOUT = 550V、IOUT = 9A。
VIN 是指次级侧电压，VOUT 和 IOUT 是指初级侧电压和反向电流 (DAB_IprimSensed_Amps = –9A)。

图 4-45. 实验 5 - 用于开路电压环路测试的 SFRA 装置图

4.4.6 实验 6

在此设置中，直流电源连接到次级侧，而电阻负载连接到初级侧。本设计在闭合电压环路中反向运行。

通过从 PowerSUITE GUI 的 Project Options 下拉菜单中选择 6: Closed Loop Voltage with Resistive Load, Sec to 
Prim Power Flow，对工程进行编译。确保按照工作条件设置电流和电压限制。

#if DAB_LAB == 6
#define DAB_CONTROL_RUNNING_ON C28X_CORE
#define DAB_POWER_FLOW DAB_POWER_FLOW_SEC_PRI
#define DAB_INCR_BUILD DAB_CLOSED_LOOP_BUILD
#define DAB_TEST_SETUP DAB_TEST_SETUP_RES_LOAD
#define DAB_PROTECTION DAB_PROTECTION_ENABLED
#define DAB_CONTROL_MODE  DAB_VOLTAGE_MODE
#define DAB_SFRA_TYPE  2
#define DAB_SFRA_AMPLITUDE (float32_t)DAB_SFRA_INJECTION_AMPLITUDE_LEVEL2
#endif

• 实验 6（闭合电压环路 - Vprim - 反向功率流）的测试设置

1. 通过点击 CCS 中的绿色运行按钮，运行工程。

2. 通过在脚本控制台中加载 JavaScript setupdebugenv_lab6.js，在监视窗口中填充所需的变量。
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图 4-46. 实验 6 - 监视视图

3. 通过将“1”写入 DAB_enableFan 和 DAB_enableRelay 来启用风扇和继电器。

4. 通过将“1”写入监视视图中的 DAB_clearTrip 变量，启用 PWM。

5. 检查 DAB_IprimSensed_Amps、DAB_iPrimSensed_Amps、DAB_vSecSensed_Volts 和 

DAB_iSecSensed_Amps 变量是否定期更新。

6. 通过写入 DAB_vPrimRef_Volts，设置输出电压（本例中为 50Vdc）。

7. 通过将“1”写入 DAB_closeGvLoop 变量，启用闭环操作。控制器会根据工作条件自动调节相移，从而

生成与 DAB_vPrimRef_Volts 匹配的初级输出电压。

8. 现在，可以逐步增加次级侧电压和 DAB_vPrimRef_Volts，并可以监视控制行为。

• 闭环电压的频率响应

1. 执行与实验 3 中相同的步骤。

测试条件：VIN = 350V、VOUT = 550V、IOUT = 9A
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VIN 是指次级侧电压，VOUT 和 IOUT 是指初级侧电压和反向电流。(DAB_IprimSensed_Amps = –9A)

图 4-47. 实验 6 - 具有反向功率流的闭合电压环路的 SFRA 开环图

使用与实验 3 中相同的控制器和增益。

4.4.7 实验 7

在此设置中，直流电源连接到次级侧，而电阻负载连接到初级侧。本设计在闭合电流环路中反向运行。

通过从 PowerSUITE GUI 的 Project Options 下拉菜单中选择 7: Closed Loop Current with Resistive Load, Sec to 
Prim Power Flow，对工程进行编译。确保按照工作条件设置电流和电压限制。

#if DAB_LAB == 7
#define DAB_CONTROL_RUNNING_ON C28X_CORE
#define DAB_POWER_FLOW DAB_POWER_FLOW_SEC_PRI
#define DAB_INCR_BUILD DAB_CLOSED_LOOP_BUILD
#define DAB_TEST_SETUP DAB_TEST_SETUP_RES_LOAD
#define DAB_PROTECTION DAB_PROTECTION_ENABLED
#define DAB_CONTROL_MODE  DAB_CURRENT_MODE
#define DAB_SFRA_TYPE  1
#define DAB_SFRA_AMPLITUDE (float32_t)DAB_SFRA_INJECTION_AMPLITUDE_LEVEL1
#endif

• 实验 7（闭合电流环路 - IPrim - 反向功率流）的测试设置

1. 通过点击 CCS 中的绿色运行按钮，运行工程。

2. 通过在脚本控制台中加载 JavaScript setupdebugenv_lab7.js，在监视窗口中填充所需的变量。

图 4-48. 实验 7 - 监视视图

3. 通过将“1”写入 DAB_enableFan 和 DAB_enableRelay 来启用风扇和继电器。

4. 通过将“1”写入监视视图中的 DAB_clearTrip 变量，启用 PWM。

5. 检查 DAB_vPrimSensed_Volts、DAB_iPrimSensed_Amps、DAB_vSecSensed_Volts 和 

DAB_iSecSensed_Amps 变量是否定期更新。

6. 通过写入 DAB_iPrimRef_Volts，设置输出电压（本例中为 –3A）。

7. 通过将“1”写入 DAB_closeGvLoop 变量，启用闭环操作。控制器会根据工作条件自动调节相移，从而

生成与 DAB_iPrimRef_Volts 匹配的初级输出电流。

8. 现在，可以逐步增加次级侧电压和 DAB_iPrimRef_Volts，并可以监视控制行为。

• 闭环电流的频率响应

1. 执行与实验 4 中相同的步骤。
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测试条件：VIN = 350V、VOUT = 550V、IOUT = 9A。
VIN 是指次级侧电压，VOUT 和 IOUT 是指初级侧电压和反向电流 (DAB_IprimSensed_Amps = –9A)。

图 4-49. 实验 7 - 具有反向功率流的闭合电流环路的 SFRA 开环图

使用与实验 4 中相同的控制器和增益。
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4.5 测试结果

以下效率测量是在闭合电压环路配置中使用正向功率流完成的。

4.5.1 闭环性能

使用实验 3 通过输出电压控制完成了闭环性能。图 1-1 显示了结果。较低输出电压的效率明显下降。效率下降主

要有两个影响因素。首先，高负载下的效率较低是由于系统中的循环电流增加，这会增加 RMS 电流，进而增加导

通损耗。第二个影响轻负载效率的因素是轻负载下的 ZVS 损耗。
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图 4-50. 单相位移 (SPS) 控制的闭环效率

通过扩展相移 (EPS) 控制，循环电流减小，而 ZVS 范围增大。这可以提高轻负载和满负载效率。EPS 控制使该

参考设计能够在较低的输出电压下工作，而单步相移 (SPS) 由于损耗较高而无法实现这一点。在低至 350V 输出

电压下可以实现 10kW 的值，在 250V 输出电压下可以达到 5kW。
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图 4-51. 扩展相移 (EPS) 控制的闭环效率
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5 设计文件

5.1 原理图

要下载原理图，请参阅 TIDA-010054 中的设计文件。

5.2 物料清单

要下载物料清单 (BOM)，请参阅 TIDA-010054 中的设计文件。

5.3 Altium 工程

要下载 Altium Designer® 工程文件，请参阅 TIDA-010054 中的设计文件。

5.4 Gerber 文件

要下载光绘文件，请参阅 TIDA-010054 的设计文件。

5.5 装配图

要下载装配图，请参阅 TIDA-010054 中的设计文件。

6 相关文档

1. 双有源电桥的 PWM 控制：综合分析和实验验证
2. 双有源电桥转换器的控制策略比较

6.1 商标
TI E2E™, C2000™, and Code Composer Studio™ are trademarks of Texas Instruments.
CHAdeMO® is a registered trademark of The Tokyo Electric Power Company.
MATLAB® is a registered trademark of The MathWorks, Inc.
Cree® is a registered trademark of Cree, Inc.
Microsoft® and Excel® are registered trademarks of Microsoft Corporation.
USB Type-C® is a registered trademark of USB Implementers Forum.
JavaScript® is a registered trademark of Oracle Corporation.
Altium Designer® is a registered trademark of Altium LLC or its affiliated companies.
所有商标均为其各自所有者的财产。

7 术语

SiC 碳化硅

DAB 双有源电桥

ZVS 零电压开关

EV 电动汽车

CCS Code Composer Studio
V2G 车辆到电网

SPS 单相移

EPS 扩展相移
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